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Safety Tips 

General Safety Summary 

Read the following safety precautions to avoid injury and prevent damage to this product or any 

products connected to it. To evade potential hazards, use this product only as specified. 

Only qualified personnel should perform maintenance. 

Avoid fire or personal injury. 

Use suitable power cord. Use only the power cord specified for this product and certified for the 

country of use. 

Connect and disconnect properly. Connect a probe with the oscilloscope before it is connected 

to measured circuits; disconnect the probe from the oscilloscope after it is disconnected from 

measured circuits. 

Ground the product. This product is grounded through the grounding conductor of the power 

cord. To avoid electric shock, the grounding conductor must be connected to earth ground. Before 

making connections to the input or output terminals of the product, ensure that the product is 

properly grounded. 

Connect the probe in a right way. The probe ground lead is at ground potential. Do not connect 

the ground lead to an elevated voltage. 

Check all terminal ratings. To avoid fire or shock hazard, check all ratings and markings on the 

product. Refer to the product manual for detailed information about ratings before making 

connections to the product. 

Do not operate without covers. Do not operate this product with covers or panels removed. 

Avoid exposed circuitry. Do not touch exposed connections and components when power is 

present. 

Do not operate with suspected failures. If you suspect there is damage to this product, have it 

inspected by qualified service personnel. 

Assure good ventilation. 

Do not operate in wet/damp environments. 

Do not operate in an explosive atmosphere. 

Keep product surfaces clean and dry. 



 

 

Safety Terms and Symbols 

Terms on Product 

The following terms may appear on the product: 

DANGER indicates an injury hazard immediately accessible as you read the marking. 

WARNING indicates an injury hazard not immediately accessible as you read the marking. 

CAUTION indicates a possible hazard to this product or other property. 

Symbols on Product 

The following symbols may appear on the product: 

 

 

Product Scrapping 

Device Recycling 

We need extract and utilize natural resources to produce this device. If you do not reclaim the 

device in a proper way, some substances it contains may become harmful or poisonous to 

environments or human bodies. To avoid them being released outside and to minimize the waste 

of natural resources, we suggest you reasonably call back this device to ensure proper recovery 

and recycling of most materials within it. 

Mains 
Disconnected 
OFF (Power) 

Mains 
Connected 
ON (Power) 

High Voltage 

Protective 
Ground 
(Earth) 

Terminal 

Measurement  
Ground 
Terminal 

CAUTION 
Refer to Manual 

Measurement 
Input Terminal 



 

 

Brief Introduction to DSO4000 Series 

DSO4000 Series oscilloscopes cover the bandwidths from 70MHz to 200MHz, and provide 

the real-time and equivalent sample rates respectively up to 1GSa/s and 25GSa/s. In addition, 

they have 7 inch color TFT LCD as well as WINDOWS-style interfaces and menus for easy 

operation. 

What’s more, the plenty menu information and the easy-to-operate buttons allow you to gain 

information as much as possible in measurement; the multifunctional knobs and the powerful 

shortcut keys help you save a lot of time in operation; the Autoset function lets you detect sine and 

square waves automatically; the Probe Check Wizard guides you to adjust the probe 

compensation and set the Probe option attenuation factor. By using the three methods the 

oscilloscope provides (context-sensitive, hyperlinks, and an index), you may master all operations 

on the device in quite a short time so as to greatly improve your efficiency in production and 

development. 

Model Channels Bandwidth Sample Rate LCD 

DSO4072 2 70MHz 1GS/s 7 inch color 

DSO4102 2 100MHz 1GS/s 7 inch color 

DSO4202 2 200MHz 1GS/s 7 inch color 

Model List of DSO4000 Series 
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1.1 Accidence of front panel and the user interface 

This section will make you understand the front operation panel of this series of digital oscilloscope 

at first before use.   

1.1.1 Front Panel 

The content below simply describes and introduces the front panel and the back part of this series 

of digital oscilloscope so that you can get familiar with this series of digital oscilloscope well within 

the shortest time. 

 

Figure 1-1 Figure of Front Panel 
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1.1.2 User Interface 

 

1. Hantek mark 

2. Display Format: 

 
3. Acquisition Mode: Normal, Peak Detect or Average 

4. Trigger Status: 

   The oscilloscope is acquiring pretriggered data. 

   All pretriggered data have been acquired and the oscilloscope is ready to accept a trigger.  

T    The oscilloscope has detected a trigger and is acquiring the posttrigger information.  

   The oscilloscope works in auto mode and is acquiring waveforms in the absence of triggers.  

   The oscilloscope is acquiring and displaying waveform data continuously in scan mode. 

●    The oscilloscope has stopped acquiring waveform data.  

S    The oscilloscope has finished a single sequence acquisition. 

5. Tool Icon: 

: If this icon lights up, it means the keyboard of the oscilloscope is locked by the host computer 

via USB control.  

: If this icon lights up, it means the USB disk has been connected. 

: YT 

: Vectors 

: Gray indicates auto persistence; Green means persistence display is enabled. When 

the icon is set to green, the time for persistence display will be shown behind it. 

: XY 

: Dots 
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: This icon lights up only when the USB slave interface is connected with the computer. 

6. Main Time Base Window 

7. Display of window’s position in data memory and data length.  

8. Window Time Base 

9. Operating Menu shows different information for different function keys.  

10. Readout shows frequency count.             

11. Readout points out horizontal waveform position 

12. Trigger Type: 

: Edge trigger on the rising edge. 

: Edge trigger on the falling edge. 

: Video trigger with line synchronization. 

: Video trigger with field synchronization. 

: Pulse Width trigger, positive polarity. 

: Pulse Width trigger, negative polarity. 

13. Pop-up Prompt           

14. Readout tells trigger level. 

15. Icon indicates whether the waveform is inverted or not.         

16. 20M Bandwidth Limit. If this icon lights up, it means the bandwidth limit is enabled, otherwise 

disabled. 

17. Icon indicates channel coupling.             

18. Channel Marker 

19. Window displays waveform. 

 

1.2 Functional Check 

Follow the steps below to perform a quick functional check to your oscilloscope. 

1.2.1 Power on the oscilloscope 

Plug in the oscilloscope and press the ON/OFF button. Then push the “UTILITY ->F6 ->F6 -> 

F6->DEFAULT” button. The default Probe option attenuation setting is 10X. 

1.2.2 Connect the oscilloscope 

Set the switch on the probe to 10X and connect the probe to Channel 1 on the oscilloscope. First, 
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align the slot in the probe connector with the protuberance on the CH1 BNC and push to connect; 

then, turn to right to lock the probe in place; after that, connect the probe tip and reference lead to 

the PROBE COMP connectors. There is a mark on the panel: Probe COMP ~5V@1KHz. 

 

 

1.2.3 Observe the waveform 

Press the AUTOSET button and you should see within a few seconds a square wave of about 5V 

peak-to-peak at 1kHz in the display. Press the CH1 MENU button twice to remove Channel 1. 

Push the CH2 MENU button and repeat Step 2 and Step 3 to observe Channel 2. 

 

1.3 Probe Examination 

1.3.1 Safety 

When using the probe, keep your fingers behind the guard on the probe body to avoid electric 

shock. Do not touch metallic portions of the probe head while it is connected to a voltage source. 

Connect the probe to the oscilloscope and connect the ground terminal to ground before you start 

any measurements. 

CH1: to connect with the probe PROBE COMP 
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1.3.2 Use of Probe Check Wizard 

Every time you connect a probe to an input channel, you should use the probe check wizard to 

verify that this probe is operating correctly. 

Use the vertical menu (for example, push the CH1 MENU button) to set the Probe option 

attenuation factor. 

1.3.3 Manual Probe Compensation 

Upon the first connection of a probe and an input channel, you should manually perform this 

adjustment to match the probe to the input channel. Uncompensated or miscompensated probes 

may lead to errors or faults in measurement. To adjust the probe compensation, follow the steps 

below. 

1. Set the Probe option attenuation in the channel menu to 10X. Set the switch on the probe to 

10X and connect the probe to Channel 1 on the oscilloscope. If you use the probe hook-tip, 

ensure it is firmly inserted onto the probe. Attach the probe tip to the PROBE COMP 

~5V@1KHz connector and the reference lead to the PROBE COMP Ground connector. 

Display the channel and then press the AUTOSET button. 

2. Check the shape of the displayed waveform. 

 

3. If necessary, use a nonmetallic screwdriver to adjust the variable capacity of your probe until 

the shape of the waveform turns to be the same as the above figure. Repeat this step as 

necessary. See the figure below for the way of adjustment. 

Compensated correctly 
 
 

Overcompensated 

 
 

Undercompensated 
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1.3.4 Probe Attenuation Setting 

Probes are of various attenuation factors which affect the vertical scale of the signal. The Probe 

Check function is used to verify if the Probe attenuation option matches the attenuation of the 

probe. 

As an alternative method to Probe Check, you can push a vertical menu button (such as the CH 1 

MENU button) and select the Probe option that matches the attenuation factor of your probe. 

Make sure that the Attenuation switch on the probe matches the Probe option in the oscilloscope. 

Switch settings are 1X and 10X.  

When the Attenuation switch is set to 1X, the probe limits the bandwidth of the oscilloscope to 

6MHz. To use the full bandwidth of the oscilloscope, be sure to set the switch to 10X. 

 

1.4 Self Calibration 

The self calibration routine helps optimize the oscilloscope signal path for maximum measurement 

accuracy. You can run the routine at any time but should always run it if the ambient temperature 

changes by 5℃ or more. For a more accurate calibration, please power on the oscilloscope and 

wait for 20 minutes until it has adequately warmed up. 

To compensate the signal path, disconnect any probes or cables from the front-panel input 

connectors. Then, push the UTILITY button, select the Do Self Cal option and follow the directions 

on the screen. 
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Chapter 2 Main Feature Description 

This chapter provides some general information that you need to learn before using an 

oscilloscope. It contains: 

 Menu and Control Keys 

 Multi-functional Knobs and Buttons 

 Signal Connectors 

 Oscilloscope Setup 

 Default Setups 

 Default Setups 

 Horizontal System 

 Vertical System 

 Trigger System 

 Save and Recal 

 Display Syetem 

 Measure System 

 Acquisition System 

 Utility System 

 Help System 

 Fast Action Buttons 

 Waveform Generator and and Power Amplifier 
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2.1 Menu and control keys 

As shown in the figure below: 

 

Figure2-1 Control keys 

All the keys are described as follows:   

 [CH1], [CH2]: display setup menus of channel 1 and channel 2. 

 [MATH]: display “ARITHMETICAL OPERATION” and “REFERENCE WAVEFORM” menu. 

 [HORIZ]: display “HORIZONTAL” menu. 

 [TRIG]: display “TRIGGER” control menu.  

 [FORCE TRIG]: It is used for finishing acquisition of the current waveform no matter whether 

the oscilloscope detects trigger, and it is mainly applied to “NORMAL” and “SINGLE” in the 

trigger mode.  

 [SAVE/RECALL]: display the “SAVE/RECALL” menu of setups and waveform.  

 [MEASURE]: display the “MEASURE” menu.  

 [ACQUIRE]: display the “ACQUIRE” menu. 

 [UTILITY]: display “UTILITY FUNCTION” menu.  

 [CURSOR]: display the “CURSOR” menu. The [V0] knob can be used for regulating the 

position of the cursor when the “CURSOR” menu is displayed and the cursor is triggered.  

 [DISPLAY]: show the “DISPLAY” menu. 

 [HELP]: enter the on-line help system.   

 [AUTOSET]: automatically set the control state of the oscilloscope so as to display suitable 

waveform.  

 [RUN/STOP]: continuously acquire waveform or stop acquisition  

 [SINGLE SEQ]: Acquire a single trigger, finish acquisition and then stop. 

 [GEN DSO]: Waveform generator output button.. 

 [GEN ON/GEN OFF]: Power Amplifier output button. 
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2.2 Multi-functional Knobs and Buttons 

 

 

 

2.3 Signal Connectors 

See the figure below to find the seven signals connectors and a pair of metal electrodes at the 

bottom of the oscilloscope panel. 

 

 

1. GEN OUT: Waveform Signal Output. 

 

F0: Hide/Show button. Push it to hide the menu options on the right side of the 

screen and give a full screen display of waveforms. Push it again to show the menu 

options.  

 

F1-F5: These five buttons are all multi-functional. They are in charge of selecting 

corresponding menu options on the screen in different menu modes. For example, in 

the UTILITY menu, F1-F5 respectively correspond to ‘System Info’ – ‘Advance’. 

 

 

F6: This functional button is mainly used to turn pages and confirm a selection, such 

as ‘next page’, ‘previous page’, and ‘press F6 to confirm’ appearing when you push 

Self Calibration option. 

V0: Multi-functional knob. Under different menu options, it supports selecting menu 

options (MEASURE), moving cursors and levels (Slope Trigger). 

Press this knob to reset data (trigger holdoff, overtime of the overtime trigger and 

slope trigger), select menu     options and so on. Easy to operate. 

F7: Push this button in single-window mode to switch between dotted line display 

and cross display. Push it in dual-window mode to perform autocruise.  
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2. SYNC/TRIG: Output the Sync signal, or input trigger signal on DDS interface. 

3. CH1, CH2: Input connectors for waveform display, through which to connect and input the 

signal to be measured. 

4. GEN AMP: Power amplifier output. 

5. EXT.TRIG: Input connector for an external trigger source, though with to connect and input 

the external trigger signal. 

6. Probe Compensation: Voltage probe compensation output and ground, used to electrically 

match the probe to the oscilloscope input circuit. The probe compensation ground and BNC 

shields connect to earth ground and are considered to be ground terminals. To avoid 

damages, do not connect a voltage source to any of these ground terminals. 

2.4 Oscilloscope Setup 

While operating the oscilloscope, you may often use three features: Autoset, saving a setup and 

recalling a setup. Hereinafter they are introduced one by one.  

Autoset: This function can be used to adjust the horizontal and vertical scales of the oscilloscope 

automatically and set the trigger coupling, type, position, slope, level and mode, etc., to acquire a 

stable waveform display. 

Saving a Setup: By default, the oscilloscope will save the setup each time before being closed, 

and automatically recall the setup once being turned on. (Note: If you modify the setup, please 

wait for more than 5 seconds before turning off the oscilloscope to ensure the proper 

storage of new settings.) You can save 10 settings permanently in the oscilloscope and reset 

them as necessary. 

Recalling a Setup: The oscilloscope can recall any of your saved setups or the default factory 

setup.   

Default Setup: The oscilloscope is preset for normal operations when it is shipped from the 

factory. This is the default setup. You may recall this setup at any time for your requirements.  

2.5 Default setups 

The default setups represent some option parameters that are set before the oscilloscope leaves 

factory for normal operations. 

When you push “UTILITY->Default” button, the oscilloscope will display the CH1 waveform and 

remove all the others. The table below gives the options, buttons and controls that change settings 

at default setup. 

Menu or System Option, Button or Knob Default Setting 

Acquire 

(Three mode options) Normal 

Averages 16 

Run/Stop Run 
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Cursor 

Type Off 

Source CH1 

Horizontal (amplitude) ±3.2div 

Vertical (time) ±4div 

Display 

Type Vectors 

Persist Off 

Format YT 

Horizontal 

Window Mode Single-window 

Trigger Knob Level 

Position 0.00s 

SEC/DIV 200μs 

Math 

Operation — 

Source CH1-CH2 

Position 0div  

FFT 

Vertical Scale 20dB 

FFT Operation   

Source CH1 

Window Hanning 

FFT Zoom X1 

Measure 
Source CH1 

Type None 

Trigger (Edge) 

Type Edge 

Source CH1 

Slope Rising 

Mode Auto 

Coupling DC 

Level 0.00v 

Trigger (Video) 

Polarity Normal 

Sync All lines 

Standard NTSC 

Trigger (Pulse) 

When = 

Set Pulse Width 1.00ms 

Polarity Positive 

Mode Auto 

Coupling DC 

Trigger (Slope) 

Slope Rising 

Mode Auto 

Coupling DC 

When = 

Trigger (Swap) 

CH1 

Type Edge 

Slope Rising 

Mode Auto 
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Coupling DC 

Level 0.00v 

CH2 

Type Edge 

Slope Rising 

Mode Auto 

Coupling DC 

Level 0.00v 

Trigger (OT) 

Source CH1 

Polarity Positive 

Mode Auto 

Time 20ns 

Vertical System, 
All Channels 

Coupling DC 

Bandwidth Limit Unlimited 

VOLTS/DIV Coarse 

Probe Voltage 

Voltage Probe Attenuation 10X 

Invert Off 

Position 0.00div (0.00V) 

VOLTS/DIV 1.00V 

The following settings do not change when you push the DEFAULT SETUP button. 

 Language Option 

 Saved Settings 

 Saved Reference Waveforms  

 Display Contrast 

 Calibration Data 

 

2.6 Horizontal System 

Use the horizontal controls to change the horizontal scale and position of waveforms. The 

horizontal position readout shows the time represented by the center of the screen, using the 

trigger time as zero. When you change the horizontal scale, the waveform will expand or contract 

to the screen center. The readout near the upper right of the screen shows the current horizontal 

position in second. W indicates ‘Window Time Base’. The oscilloscope also has an arrow icon at 

the top of the graticule to indicate the horizontal position. 
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2.6.1 Horizontal control knob 

The horizontal knob [SEC/DIV] changes the horizontal scale (time base), and the [POSITION] 

knob changes the horizontal position (triggered displacement) triggered in the internal memory. 

The center of the screen in the horizontal direction is a time reference point of the waveform. 

Change of the horizontal scale will cause expansion or contraction of the waveform relative to the 

center of the screen, while the change of the horizontal position is relative to the position of a 

trigger point. 

Horizontal POSITION knob 

1. Regulate the horizontal position (trigger the position relative to the center of the display screen) 

of the waveform (including MATH). The resolution of this control knob is changed according to 

the time base.  

2. Use the press down function of this knob to make the horizontal displacement return to zero, 

namely back to the central position of the screen.   

[SEC/DIV] knob 

1. The knob is used for changing the horizontal time scale so as to conveniently observe the most 

suitable waveform.   

2. The knob is used for regulating the main time base. When the window expansion mode is 

adopted, the knob is used for changing the expansion time base so as to change the window 

width.   

Each option in HORIZ MENU is described as follows. 

Press [SEC/DIV] key to display the horizontal menu “HORI MENU”, and window expansion can be 

implemented at this menu. 

Options Settings Comments 

 

Window 

Control 

 

Major Window 

Minor Window 

 

Selects the major or minor window in dual-window mode. The 

window is highlighted once selected. Press this option button 

in single-window mode to enter the daul-window mode. 

 

 

Mark 

Right arrow 

Left arrow 

Set/Clear 

Clear All 

This function is usable only in dual-window mode. It sets 

marks at some waveform record locations that users are 

interested in, and searches for these marks by right and left 

arrows. Then it positions the window to this mark for further 

observation. 

HORIZONTAL POSITION Knob 

SEC/DIV 
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Page2/2 

 

Holdoff 

 

None 

Select this menu and turn the multi-functional knob to adjust 

the trigger holdoff time within the range of 100ns-10s. Select 

this menu and push the multi-functional knob to reset the 

holdoff time with the starting value 100ns. 

 

 

Autoplay 

 

 

None 

This function is usable in dual-window mode. Push this menu 

button and auto move it from left to right at a specified speed. 

In the expanded window will display corresponding 

waveforms until it stops once reaching the rightmost side of 

the major scan window. 

Time/Div 
Coarse 

Fine 

 

Horiz 

Position 

Coarse 

Fine 

 

Window expansion 

Window expansion is used for amplifying a segment of waveform so as to check details. The 

window expansion time base setup cannot be slower than the setup of the main time base. In the 

window expansion region, a selection region can be moved leftwards and rightwards by the 

horizontal [POSITION] knob or enlarged and reduced by revolving the [SEC/DIV] knob. The 

window expansion time base has higher resolution relative to the main time base. The smaller the 

window expansion time base is, the higher the horizontal expansion multiple of the waveform is. 

 

Carry out the following steps to observe details of local waveform: 

1. Press [HORI MENU] to display the “HORIZON” menu. 

2. Press “Window Ctr” menu. 

3. Revolve [SEC/DIV] (to regulate the size of the window) and the horizontal [POSITION] (to 

regulate the position of the window) to select the window of the waveform to be observed. The 

expansion time base cannot be slower than the main time base. 

Press the “Minor Window” button after the window is setting well. 
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Single-window Mode 

 

Dual-window Mode (Full Screen) 

 

Notes: 

1. For more information of the trigger holdoff, see Trigger Controls.  

2. In single-window mode, press F0 to hide or show the menus on the right side. The 

dual-window mode does not support the menu hiding function.  

2.6.2 Display Scan mode  

When the time base is set to be 80ms/div or more slowly and the trigger mode is set to “Auto”, the 

oscilloscope enters the scan mode. At this mode, waveform display is renewed from left to right. At 

the mode, no waveform trigger or horizontal position control exist. The channel coupling should be 

set as direct current when a low-frequency signal is observed at the scan mode.  

 

Major Window 

Minor Window 

(Expanded Window) 

Location of expanded window data in memory 
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2.7 Vertical System 

2.7.1 Vertical Controls 

Vertical controls can be used to display and remove waveforms, adjust vertical scale and position, 

set input parameters and perform math calculations. Each channel has a separate vertical menu 

to set. See below for menu description. 

 

1. VERTICAL POSITION Knob 

Move the channel waveform up and down on the screen. In dual-window mode, move the 

waveforms in both windows at the same time in a same direction. Push this knob to return 

waveforms to the vertical center position on the screen. Two channels correspond to two knobs. 

2. VOLT/DIV Knob 

Control the oscilloscope to magnify or attenuate the source signal of the channel waveform. The 

vertical size of the display on the screen will change (increase or decrease) to the ground level. 

Also you may use this knob to switch between coarse and fine. 

3. Menu (CH1, CH2): Display vertical menu options; turn on or off the display of channel 

waveforms.  

Options Settings Comments 

Coupling 

DC 

AC 

Ground 

DC passes both DC and AC components of the input signal. 

AC blocks the DC component of the input signal and 

attenuates signals below 10Hz. 

Ground disconnects the input signal. 

20MHz Bandwidth 

Limit 

Unlimited 

Limited 

Limits the bandwidth to reduce display noise; filters the 

signal to eliminate noise and other unnecessary HF 

components. 

VOLTS/DIV 
Coarse 

Fine 

Selects the resolution of the VOLTS/DIV knob. 

Coarse defines a 1-2-5 sequence. Fine changes the 

resolution to small steps between the Coarse settings. 

VERTICAL POSITION Knob 

VOLT/DIV Knob 
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Probe Attenuation 

1X 

10X 

100X 

1000X 

Selects a value according to the probe attenuation factor so 

as to ensure correct vertical readouts. Reduce bandwidth to 

6MHz when using a 1X probe. 

Invert 
Off 

On 
Inverts the waveform relative to the reference level. 

Coupling 

 If the channel adopts a DC coupling mode, you can quickly measure the DC component of the 

signal by observing the difference between the waveform and the signal ground.   

 If the channel adopts an AC coupling mode, the DC component in the signal is filtered. By this 

mode, the AC component of the signal is displayed at a higher sensitivity.  

 If the channel adopts a GND coupling mode, cut off the input signal. Inside the channel, the 

channel input is connected with a zero volt reference electric level. 

Fine Resolution 

In the fine resolution setting, the vertical scale readout displays the actual VOLTS/DIV setting. The 

vertical scale changes only after you adjust the VOLTS/DIV control and set to coarse. 

Remove Waveform Display 

To remove a waveform from the screen, first push the menu button to display the vertical menu, 

then push again to remove the waveform. A channel waveform which is unnecessary to be 

displayed can be used as a trigger source or for math operations. 

4. MATH MENU: Display the waveform math operations. See the table below for details. 

The MATH menu contains source options for all math operations. 

Operations Source Options Comments 

＋ CH1+CH2 Add Channel 1 to Channel 2.  

－ 

CH1-CH2 
Subtract the Channel 2 waveform from the Channel 1 

waveform. 

CH2-CH1 
Subtract the Channel 1 waveform from the Channel 2 

waveform. 

X CH1xCH2 Channel 1 multiply channel 2 

/ 
CH1/CH2 Channel 1 divide channel 2 

CH2/CH1 Channel 2 divide channel 1 

FFT CH1 or CH2 

Three types of window available for selection: Hanning, 

Flattop, Rectangular.  

Zoom: Use the FFT Zoom button to adjust the window size. 

Scale: x1, x2, x5, x10. 

Note: All selected menus are highlighted in orange. 

2.7.2 Math FFT 

This chapter elaborates how to use the Math FFT (Fast Fourier Transform). You can use the Math 



Basic Operation 

DSO4000 Series Digital Storage Oscilloscope                                                         17 

FFT mode to convert a time-domain (YT) signal into its frequency components (spectrum), and to 

observe the following types of signals: 

 Analyze harmonics in power cords; 

 Measure harmonic content and distortion in systems; 

 Characterize noise in DC power supplies; 

 Test impulse response of filters and systems; 

 Analyze vibration. 

To use the Math FFT mode, perform the following tasks: 

 Set the source (time-domain) waveform; 

 Display the FFT spectrum; 

 Choose a type of FFT window; 

 Adjust the sample rate to display the fundamental frequency and harmonics without aliasing; 

 Use zoom controls to magnify the spectrum;  

 Use cursors to measure the spectrum. 

2.7.2.1 Setting Time-domain Waveform 

It is necessary to set the time-domain (YT) waveform before using the FFT mode. Follow the steps 

below. 

1. Push the AUTOSET button to display a YT waveform. 

2. Turn the VERTICAL POSITION knob to vertically move the YT waveform to the center (zero 

division) so as to ensure the FFT will display a true DC value. 

3. Turn the HORIZONTAL POSITION knob to position the part of the YT waveform to be 

analyzed in the center eight divisions of the screen. The oscilloscope uses the 2048 center 

points of the time-domain waveform to calculate the FFT spectrum. 

4. Turn the VOLTS/DIV knob to ensure the entire waveform remains on the screen. If the entire 

waveform is invisible, the oscilloscope may display wrong FFT results by adding 

high-frequency components. 

5. Turn the SEC/DIV knob to provide the resolution you need in the FFT spectrum. 

6. If possible, set the oscilloscope to display multiple signal cycles. 

If you turn the SEC/DIV knob to select a faster setting (fewer cycles), the FFT spectrum will display 

a larger frequency range and reduce the possibility of FFT aliasing. 

To set the FFT display, follow the steps below. 

1. Push the MATH MENU button; 

2. Set the Operation option to FFT; 

3. Select the Math FFT Source channel. 

In many situations, the oscilloscope can also generate a useful FFT spectrum despite the YT 
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waveform not being triggered. This is especially true if the signal is periodic or random (such as 

noise). 

Note: You should trigger and position transient or burst waveforms as close as possible to 

the screen center. 

Nyquist Frequency 

The highest frequency that any real-time digital oscilloscope can measure without errors is half of 

the sample rate, which is called the Nyquist frequency. Frequency information beyond the Nyquist 

frequency is undersampled which brings about the FFT aliasing. The math function can convert 

the center 2048 points of the time-domain waveform to an FFT spectrum. The resulting FFT 

spectrum contains 1024 points from DC (0Hz) to the Nyquist frequency. Usually, the screen 

compresses the FFT spectrum horizontally to 250 points, but you can use the FFT Zoom function 

to expand the FFT spectrum so that you can clearly view the frequency components at each of the 

1024 data points in the FFT spectrum. 

Note: The oscilloscope’s vertical response is a little bit larger than its bandwidth (70MHz, 

100MHz or 200MHz, depending on the model; or 20MHz when the Bandwidth Limit option is 

set to Limited). Therefore, the FFT spectrum can display valid frequency information above 

the oscilloscope bandwidth. However, the amplitude information near or above the 

bandwidth will not be accurate. 

2.7.2.2 Displaying FFT Spectrum 

Push the MATH MENU button to display the Math menu. Use the options to select the Source 

channel, the Window algorithm and the FFT Zoom factor. Only one FFT spectrum can be 

displayed at a time. 

Math FFT Options Settings Comments 

Source CH1, CH2 Choose a channel to be the FFT source. 

Window 
Hanning, Flattop, 

Rectangular 

Select a type of the FFT window. For more 

information, refer to Section 2.3.  

FFT Zoom X1, X2, X5, X10 

Change the horizontal magnification of the FFT 

display. For detailed information, refer to Section 

5.3.1.6. 
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1. Frequency at the center graticule line 

2. Vertical scale in dB per division (0dB=1VRMS) 

3. Horizontal scale in frequency per division 

4. Sample rate in number of samples per second 

5. FFT window type 

2.7.2.3 Selecting FFT Window 

Using windows can eliminate the spectral leakage in the FFT spectrum. The FFT algorithm 

assumes that the YT waveform repeats all the time. When the number of cycles is integral (1, 2, 

3 ...), the YT waveform starts and ends at the same amplitude and there are no discontinuities in 

the signal shape. 

If the number of cycles is nonintegral, the YT waveform starts and ends at different amplitudes and 

transitions between the start and end points will cause discontinuities in the signal that introduces 

high-frequency transients. 

Fundamental frequency component 
Frequency component 

2 3 4 

5 

1 



Basic Operation 

DSO4000 Series Digital Storage Oscilloscope                                                         20 

 

Applying a window to the YT waveform changes the waveform so that the start and stop values 

are close to each other, which reduces the discontinuities. 

 

The Math FFT function has three FFT Window options. There is a trade-off between frequency 

resolution and amplitude accuracy for each type of window. You shall determine which one to 

choose according to the object you want to measure and the source signal characteristics. 

Window Measurement Characteristics 

Hanning 
Periodic 
Waveform 

Better frequency, poorer amplitude accuracy than Flattop 

Flattop 
Periodic 
Waveform 

Better amplitude, poorer frequency accuracy than Hanning 

Rectangular 
Pulse or Transient 
Waveform 

Special-purpose window applicable to discontinuous 
waveforms. This is actually the same as no windows.  
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2.7.2.4 FFT Aliasing 

Problems occur when the time-domain waveform acquired by the oscilloscope contains frequency 

components higher than the Nyquist frequency. The frequency components above the Nyquist 

frequency will be undersampled and displayed as lower frequency components that ‘fold back’ 

from the Nyquist frequency. These erroneous components are called aliases. 

2.7.2.5 Eliminating Aliases 

To eliminate aliases, use the following methods. 

 Turn the SEC/DIV knob to set a faster sample rate. Because the Nyquist frequency increases 

as you increase the sample rate, the aliased frequency components will be displayed correct. 

If too many frequency components appear on the screen, you may use the FFT Zoom option 

to magnify the FFT spectrum. 

 If there is no need to observe the frequency components above 20MHz, set the Bandwidth 

Limit option to Limited. 

 Filter the signal input from outside and limit the bandwidth of the source waveform to lower 

than the Nyquist frequency. 

 Identify and ignore the aliased frequencies. 

 Use zoom controls and cursors to magnify and measure the FFT spectrum. 

2.7.2.6 Magnifying and Positioning FFT Spectrum 

You may scale the FFT spectrum and use cursors to measure it through the FFT Zoom option 

which enables the horizontal magnification. To vertically magnify the spectrum, use the vertical 

controls. 

Horizontal Zoom and Position 

You can use the FFT Zoom option to magnify the FFT spectrum horizontally without changing the 

sample rate. The available zoom factors are X1(default), X2, X5 and X10. When the zoom factor is 

set to X1 and the waveform is located at the center graticule, the left graticule line is at 0Hz and 

the right is at the Nyquist frequency. 

You magnify the FFT spectrum to the center graticule line when you change the zoom factor. That 

is, the axis for horizontal magnification is the center graticule line. Turn the Horizontal Position 

knob clockwise to move the FFT spectrum to the right. Push the SET TO ZERO button to position 

the center spectrum at the center of the graticule. 

Vertical Zoom and Position 

When the FFT spectrum is being displayed, the channel vertical knobs become the zoom and 

position controls corresponding to their respective channels. The VOLTS/DIV knob provides the 

following zoom factors: X1(default), X2, X5 and X10. The FFT spectrum is magnified vertically to 

the marker M (math waveform reference point on the left edge of the screen). Turn the VERTICAL 

POSITION knob clockwise to move up the spectrum. 
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2.7.2.7 Using Cursors to Measure FFT Spectrum 

You may use cursors to take two measurements on the FFT spectrum: amplitude (in dB) and 

frequency (in Hz). Amplitude is referenced to 0db that equals 1VRMS here. You may use cursors 

to measure at any zoom factor. 

Push the CURSOR button, choose the Source option and then select Math. Press the Type option 

button to select between Amplitude and Frequency. Click the SELECT CURSOR option to choose 

a cursor. Then use the V0 knobs to move Cursor S and Cursor E. Use the horizontal cursor to 

measure the amplitude and the vertical cursor to measure the frequency. Now the display at the 

DELTA menu is just the measured value, and the values at Cursor S and Cursor E. 

Delta is the absolute value of Cursor S minus Cursor E. 

 

2.8 Trigger System 

The trigger determines when the oscilloscope begins to acquire data and display a waveform. 

Once a trigger is properly set up, the oscilloscope can convert unstable displays or blank screens 

to meaningful waveforms. Here introduce some basic concepts about trigger. 

Trigger Source: The trigger can be generated with multiple sources. The most common one is the 

input channel (alternative between CH1 and CH2). Whether the input signal is displayed or not, it 

can trigger normal operations. Also the trigger source can be any signal connected to an external 

trigger channel or the AC power line (only for Edge triggers). The source with the AC power line 

shows the frequency relationship between the signal and the AC commercial power. 

Trigger Type: The oscilloscope has six types of triggers: Edge, Video, Pulse Width, Slope, 

Overtime and Swap.  

 Edge Trigger uses the analog or digital test circuits for triggering. It happens when the 

input trigger source crosses a specified level in a specified direction. 

 Video Trigger performs a field or line trigger through standard video signals. 

 Pulse Width Trigger can trigger normal or abnormal pulses that meet trigger conditions. 

Frequency Cursors Amplitude Cursors 
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 Slope Trigger uses the rise and fall times on the edge of signal for triggering. 

 Overtime Trigger happens after the edge of signal reaches the set time. 

 Swap Trigger, as a feature of analog oscilloscopes, gives stable displays of signals at 

two different frequencies. Mainly it uses a specific frequency to switch between two 

analog channels CH1 and CH2 so that the channels will generate swap trigger signals 

through the trigger circuitry. 

Trigger Mode: You can select the Auto or Normal mode to define how the oscilloscope acquires 

data when it does not detect a trigger condition. Auto Mode performs the acquisition freely in 

absence of valid trigger. It allows the generation of untriggered waveforms with the time base set 

to 80ms/div or slower. Normal Mode updates the displayed waveforms only when the 

oscilloscope detects a valid trigger condition. Before this update, the oscilloscope still displays the 

old waveforms. This mode shall be used when you want to only view the effectively triggered 

waveforms. In this mode, the oscilloscope displays waveforms only after the first trigger. To 

perform a single sequence acquisition, push the SINGLE SEQ button. 

Trigger Coupling: Trigger Coupling determines which part of the signal will be delivered to the 

trigger circuit. This can help to obtain a stable display of the waveform. To use trigger coupling, 

push the TRIG MENU button, select an Edge or Pulse trigger, and then select a Coupling option. 

Trigger Position: The horizontal position control establishes the time between the trigger position 

and the screen center. 

Slope and Level: The Slope and Level controls help to define the trigger. The Slope option 

determines whether the trigger point is on the rising or falling edge of a signal. To perform the 

trigger slope control, press the TRIG MENU button, select an Edge trigger, and use the Slope 

button to select rising or falling. The TRIGGER LEVEL knob controls the trigger point is on which 

position of the edge. 

 

 

2.8.1 Trigger Controls 

The trigger can be defined through the Trigger Menu and front-panel controls. There are six types 

of trigger: Edge, Video, Pulse Width, Swap, Slope and Overtime. Refer to the following tables to 

find a different set of options for each type of trigger. 

Trigger slope can be rising or falling 

Rising Edge Falling Edge 

Trigger level can be 
adjusted vertically 



Basic Operation 

DSO4000 Series Digital Storage Oscilloscope                                                         24 

 

1. Level 

It sets the amplitude level the signal must cross to cause an acquisition when using the Edge or 

Pulse Width trigger. 

2. Set to 50% 

The trigger level is set to the vertical midpoint between the peaks of the trigger signal. 

3. Force Trigger 

Used to complete an acquisition regardless of an adequate trigger signal. This button becomes 

useless if the acquisition is already stopped. 

4. TRIG MENU 

Push this button to display trigger menus. The edge trigger is in common use. See the table below 

for details. 

Options Settings Comments 

Trigger Type   

Edge Video 

Pulse Slope 

Swap Overtime 

 

By default the oscilloscope uses the edge trigger which triggers 

the oscilloscope on the rising or falling edge of the 

input signal when it crosses the trigger level (threshold). 

Source 

CH1 

CH2 

EXT 

EXT/5 

AC Line 

Select the input source as the trigger signal. 

CH1, CH2: No matter the waveform is displayed or not, a 

certain channel will be triggered. 

EXT: Does not display the trigger signal and allows a trigger 

level range of +1.6V to -1.6V. 

EXT/5: Same as EXT option, but attenuates the signal by a 

factor of 5 and allows a trigger level range of +8V to -8V. 

AC Line: Uses a signal derived from the power cord as the 

trigger source. 

Mode 
Auto 

Normal 

Select a trigger mode. 

By default, the oscilloscope uses the Auto mode. In this mode, 

the oscilloscope is forced to trigger when it does not detect a 
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trigger within a certain amount of time based on the SEC/DIV 

setting. The oscilloscope goes into the scan mode at 80ms/div 

or slower time base settings. 

In the Normal mode, the oscilloscope updates the display only 

when it detects a valid trigger condition. New waveforms are not 

displayed until they replace old ones. Use this mode to just view 

valid triggered waveforms. Only after the first trigger does the 

display appear. 

Coupling 

AC 

DC 

HF Reject 

LF Reject 

Select the components of the trigger signal applied to the trigger 
circuitry. 
AC: Blocks DC components and attenuates signals below 
10Hz. 
DC: Passes all components of the signal. 
HF Reject: Attenuates the high-frequency components above 
80kHz. 
LF Reject: Blocks DC components and attenuates the 
low-frequency components below 8kHz. 

NOTE: Trigger coupling only affects the signal passed through the trigger system. It does 

not affect the bandwidth or coupling of the signal displayed on the screen. 

Video Trigger 

Options Settings Comments 

Video  

With Video highlighted, an NTSC, PAL or SECAM standard 

video signal will be triggered. The trigger coupling is preset to 

AC.  

Source 

CH1 

CH2 

EXT 

EXT/5 

Select the input source as the trigger signal. Ext and Ext/5 use 

the signal applied to the EXT TRIG connector as the source. 

Polarity 
Normal 

Inverted 

Normal: Triggers on the negative edge of the sync pulse. 

Inverted: Triggers on the positive edge of the sync pulse. 

Sync 

All Lines 

Line Number 

Odd Field 

Even Field 

All Fields 

Choose a proper video sync. When selecting Line Number for 

the Sync option, you may use the User Select knob to specify a 

line number. 

Standard 
NTSC 

PAL/SECAM 
Choose a video standard for sync and line number count. 

Note: When you choose Normal Polarity, the trigger always occurs on negative-going sync 

pulses. If the video signal contains positive-going sync pulses, use the Inverted Polarity 

option. 

Pulse Width Trigger 

You can use it to trigger on aberrant pulses. 
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Options Settings Comments 

Pulse  

With Pulse highlighted, the trigger occurs on pulses that meet 

the trigger condition (defined by the Source, When and Set 

Pulse Width options). 

Source 

CH1 

CH2 

EXT 

EXT5 

Select the input source as the trigger signal. 

When 

= 
≠ 
< 
> 

Select the trigger condition. 

Set Pulse 

Width 

20ns to 

10.0sec 

With Set Pulse Width highlighted by pressing F4, turn the 

multi-functional knob to set the pulse width. 

Polarity 
Positive 

Negative 
Select to trigger on positive or negative pulses. 

Mode 
Auto 

Normal 

Select the type of trigger. The Normal mode is best for most 

pulse width trigger applications. 

Coupling 

AC 

DC 

HF Reject 

LF Reject 

Select the components of the trigger signal applied to the 

trigger circuit. 

More  Switch between submenu pages. 

Trigger When: The pulse width of the source must be ≥5ns so that the oscilloscope can detect the 

pulse. 

 

＝, ≠: Within a ±5% tolerance, triggers the oscilloscope when the signal pulse width is equal to 
or not equal to the specified pulse width.  

Triggers when pulse is 

equal to width setting ±5% 

= Trigger Point 

Threshold level 

Triggers when pulse is 

greater than width setting 

Triggers when pulse is not 

equal to width setting ±5% 

Tolerance Tolerance 

Threshold level 

Triggers when pulse is 

less than width setting 
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＜, ＞: Triggers the oscilloscope when the source signal pulse width is less than or greater 
than the specified pulse width. 

Slope Trigger: Judges trigger according to the time for rising or falling, more flexible and accurate 

than the Edge trigger.  

Options Settings Comments 

Slope   

Source 

CH1 

CH2 

EXT 

EXT5 

Select the input source as the trigger signal. 

Slope 
Rising 

Falling 
Select the slope type of signal. 

Mode 
Auto 

Normal 

Select the type of trigger. The Normal mode is best for 

most pulse width trigger applications. 

Coupling 

AC 

DC 

Noise Reject 

HF Reject 

LF Reject 

Selects the components of the trigger signal applied to 

the trigger circuitry. 

Next Page   

Vertical 
V1 

V2 

Adjust the vertical window by setting two trigger levels. 

Select this option and press F3 to choose V1 or V2.  

When 

= 
≠ 
< 
> 

Select the trigger condition. 

Time 20ns to 10.0sec 
With this option highlighted by pressing F4, turn the 

multi-functional knob to set the time span. 

Swap Trigger: As a feature of analog oscilloscopes, it gives stable displays of signals at two 

different frequencies. Mainly it uses a specific frequency to switch between two analog channels 

CH1 and CH2 so that the channels will generate swap trigger signals through the trigger circuitry. 

Options Settings Comments 

Swap 

Trigger 
  

Mode 
Auto 

Normal 
Select the type of trigger. 

Channel 
CH1 

CH2 

Push an option such as CH1, select the channel trigger 

type and set the menu interface. 

Below list options in submenus. Swap Trigger allows CH1 and CH2 to select different trigger 

modes and to display waveforms on a same screen. That is, both channels can choose the 

following four trigger modes. 

Type Edge  

Slope 
Rising 

Falling 
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Coupling 

AC 

DC 

HF Reject 

LF Reject 

Push F3 or F4 to select the components of the trigger signal 

applied to the trigger circuitry.  

Type Video  

Polarity 
Normal 
Inverted 

 

Standard 
NTSC 

PAL/SECAM 
 

Sync 

All Lines 

Line Number 

Odd Field 

Even Field 

All Fields 

Select by F4, F5. 

Type Pulse  

Polarity 
Positive 
Negative 

 

When 

= 

≠ 

< 

> 

Select by F3. 

Set Pulse 

Width 
Pulse Width 

Push F4 to select. Adjust the multi-functional knob V0 to set 

the pulse width. 

Coupling 

AC 

DC 

Noise Reject 

HF Reject 

LF Reject 

Select by F5. 

Type Slope  

Slope 
Rising 

Falling 
Select the slope type of signal. 

Mode 
Auto 

Normal 

Select the type of trigger. The Normal mode is best for most 

pulse width trigger applications. 

Coupling 

AC 

DC 

Noise Reject 

HF Reject 

LF Reject 

Selects the components of the trigger signal applied to the 

trigger circuitry. 

Vertical 
V1 

V2 

Adjust the vertical window by setting two trigger levels. 

Select this option and press F3 to choose V1 or V2. 

When 

= 

≠ 

< 

> 

Select the trigger condition. 

Time 20ns to 10.0sec Press F4 to select this option. Turn the multi-functional 
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knob to set the time span. 

Overtime Trigger: In Pulse Width trigger, you may sometimes be puzzled with the long time for 

trigger, as you do not need a complete pulse width to trigger the oscilloscope, but want the trigger 

occurs just upon the overtime point. This is called Overtime Trigger. 

Options Settings Comments 

Type OT  

Source 
CH1 

CH2 
Select the trigger source. 

Polarity 
Positive 

Negative 
Select to trigger on positive or negative pulses. 

Mode 
Auto 

Normal 
 

Overtime    
Press F5 to select Overtime option and adjust V0 to set the 

time. 

Coupling 

AC 

DC 

HF Reject 

LF Reject 

Selects the components of the trigger signal applied to the 

trigger circuitry. 

Holdoff: To use Trigger Holdoff, push the HORIZONTAL Menu button and set the Holdoff Time 

option by pressing F4. The Trigger Holdoff function can be used to generate a stable display of 

complex waveforms (such as pulse trains). Holdoff is the time between when the oscilloscope 

detects one trigger and when it is ready to detect another. During the holdoff time, the oscilloscope 

will not trigger. For a pulse train, the holdoff time can be adjusted to let the oscilloscope trigger only 

on the first pulse in the train. 

 

2.9 Save/Recall 

Press the SAVE/RECALL button to save or recall oscilloscope setups or waveforms. 

The first page shows the following menu. 

Options Settings Comments 

REF   

Source 
CH1 

CH2  
Select a waveformsource to store. 

Trigger Level 

Indicates 
Trigger Points 

Holdoff Holdoff 

Acquisition Interval Acquisition Interval 



Basic Operation 

DSO4000 Series Digital Storage Oscilloscope                                                         30 

MATH 

Location 
RefA 

RefB 
Select the reference location to store or recall a waveform. 

Operation 

Save Save the source waveform to the selected reference location. 

Recall Recall saved source waveform to the selected reference location. 

Close Close Ref channel. 

Page 2/2 

Media 

Flash Save the source waveform to flash. 

USB Save the source waveform to USB device. 

SD Save the source waveform to SD card. 

Back Return to main menu. 

 

Options Settings Comments 

Setup   

Storage 
Local Memory 

USB  

Store the current setups to the USB disk or the memory of the 

oscilloscope.  

Location 0 to 9 

Specify the memory location in which to store the current 

waveform settings or from which to recall the waveform settings. 

Use the F2 or F3 button to select. 

Operation 

Save Complete the saving operation. 

Recall 

Recall the oscilloscope settings stored in the location selected in 

the Setup field. Push the Default Setup button to initialize the 

oscilloscope to a known setup. 

Back Return to main menu. 

 

Options Settings Comments 

CSV   

Source 
CH1 

CH2 

Store the current setups to the USB disk or the memory of the 

oscilloscope.  

Operation 

Save Save waveform data as .CSV file to external storage. 

Recall Recall the saved .CSV file.  

Delete Delete .CSV file 

File List 
Close Close file list. 

Open Open file list. 

Back Return to main menu. 

 

Options Settings Comments 

Default  
Push the Default softkey to initialize the oscilloscope to a known 

setup. Please refer to Default Setup. 
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See below for waveform menus.  

 

Note: The oscilloscope will save the current settings if you wait 5 seconds after the last 

modification, and it will recall these settings the next time you power on the oscilloscope. 

2.10 Display System 

[DISPLAY] is a function key of the display system.    

Page 1 of the display system function menu: 

Option Setup Description 

Type 
Vector 

Dots 

The sampling points are displayed in a link line manner. 

No interpolation link line is displayed between the sampling points. 

Display sample points directly 

Persist 

Auto, 0.2s  

0.4s, 0.8s 

1.0s,2.0s 

4.0s、8.0s 

∞ 

Set the maintained display time length of each displayed sampling 

point. 

Format   
YT 

XY 

YT format shows the vertical voltage in relation to time (horizontal 

scale); XY format displays a dot between CH1 and CH2 each time 

Contrast  
0-15 16 ranks adjustable, with a progress bar to display; Press F5 to 

select this option. Turn the multi-functional knob to adjust. 

Page 1/2  Skip to the next page.   

 

Page 2 of the display system function menu: 

Option  Setup  Description  

Grid 

Dotted line 

Real line 

Off 

Only horizontal coordinate and vertical coordinate in the middle of the 

level will display on the screen when grid is off. 

Grid 

Intensity 
 0-15 16 ranks adjustable, with a progress bar to display 

The white waveforms on the menu is 

the recalled RefA waveform 

At most 9 groups of 

setups can be stored  
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Refresh 

Rate 
 Auto, 30 frame, 40 frame, 50frame 

Wave 

Intensity 
 0-15 16 ranks adjustable, with a progress bar to display 

 

2.10.1 XY Format 

The XY format is used to analyze phase differences, such as those represented by Lissajous 

patterns. The format plots the voltage on CH1 against the voltage on CH2, where CH1 is the 

horizontal axis and CH2 is the vertical axis. The oscilloscope uses the untriggered Normal 

acquisition mode and displays data as dots. The sampling rate is fixed at 1 MS/s. 

The oscilloscope can acquire waveforms in YT format at any sampling rate. You may view the 

same waveform in XY format. To perform this operation, stop the acquisition and change the 

display format to XY. 

The table below shows how to operate some controls in XY format. 

Controls Usable or not in XY format 

CH1 VOLTS/DIV and VERTICAL 

POSITION controls 
Set the horizontal scale and position  

CH2 VOLTS/DIV and VERTICAL 

POSITION controls 
Continuously set the vertical scale and position 

Reference or Math Unusable 

Cursors Unusable 

Autoset (display format reset to YT) Unusable 

Time base controls Unusable 

Trigger controls Unusable 

2.11 Measure System 

The oscilloscope can use scale and cursor for measurement or automatic measurement, so that 

users can fully understand the measured signals.    

2.11.1 Scale measurement 

By using the method, estimation can be made quickly and intuitively. For instance, waveform 

amplitude can be observed, and a probable measurement result is judged according to the vertical 

scale. The method realizes simple measurement by multiplying the vertical scale number of the 

signal with the vertical gear Volt/div.     

2.11.2 Cursor measurement 

[CURSORS] is a function key for cursor measurement. 

The cursor measurement includes two modes: Manual mode and Tracking mode.   
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1. Manual mode: 

Horizontal cursors or vertical cursors appear in pair to measure time or voltage, and the distance 

between the cursors can be manually regulated. The signal source should be set as a waveform to 

be measured before the cursors are used.  

2. Tracking mode: 

A horizontal cursor is intersected with a vertical cursor to form a cross cursor. The cross cursor is 

automatically located on the waveform, and the horizontal position of the cross cursor on the 

waveform is regulated by selecting “Cur A” or “Cur B” and rotating the [UNIVERSAL] knob. The 

coordinates of the cursor point will be displayed on the screen of the oscilloscope.   

 

Manual cursor measurement mode 

Manual cursor measurement function menu: 

Option   Setup  Description 

Cursor mode Manual  Set the manual cursor measurement  

Types  
Voltage 

 Time  

Manually use the cursor to measure voltage parameters.  

Manually use the cursor to measure time parameters.   

Signal sources 

CH1 

CH2 

MATH 

REF A 

REF B 

Select the input channel of the measured signal.   

Cursor select 

S 

 

E 

Select the option using the [UNIVERSAL] knob to regulate 

the position of “S”.  

Select the option using the [UNIVERSAL] knob to regulate 

the position of “E”. 

The manual cursor measurement mode is used for measuring the coordinate values and 

increments of one pair of horizontal or vertical cursors. Ensure the signal source to be set rightly 

when using the cursors, as shown in figure 2-38. 

■ Voltage cursor: The voltage cursor appears on the display screen as a horizontal line, and it 

can be used for measuring vertical parameters.  

■ Time cursor: The time cursor appears on the display screen as a vertical line, and it can be 

used for measuring horizontal parameters.   

■ Cursor movement:  Select the cursors first and use the [UNIVERSAL] knob to move cursor A 

and cursor B, wherein the values of the cursors will appear on the right upper corner of the screen 

during movement. 

The operation steps are as follows:    

1. Press [CURSORS] to skip to the “CURSOR” menu. 

2. Press “Type” to select “Voltage” or “Time”. 
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3. Press “Signal source” to select CH1, CH2, MATH, RefA or RefB. 

4. Select “S” and revolve the [UNIVERSAL] knob to regulate the position of “S”.    

5. Select “E” and revolve the [UNIVERSAL] knob to regulate the position of “E”. 

6. The measurement value list on the menu button “F5” 

 

Cursor tracking measurement mode 

Cursor tracking function menu:  

Option  Setup  Description  

Cursor mode Tracking Set the tracking cursor measurement.  

Source 

CH1 

CH2 

MATH 

RefA 

RefB 

Select a waveform source to take the cursor measurement. 

Select Cursor 

“S” 

 

“E” 

Select the option using the [UNIVERSAL] knob to regulate the 

position of “S”.   

Select the option using the [UNIVERSAL] knob to regulate the 

position of “E”. 

 

At cursor tracking measurement mode, the cross cursors are displayed on the measured 

waveform, the cursors are automatically located on the waveform by moving the horizontal 

position between the cursors, and simultaneously the horizontal and vertical coordinates of the 

current located point, and the horizontal and vertical increments between the two cursors are 

displayed. The horizontal coordinate is displayed as a time value, and the vertical coordinate is 

displayed as a voltage value, as shown in figure 2-39. 

The operation steps are as follows: 

1. Press [CURSORS] to skip to the “CURSOR” menu. 

2. Select “Cursor type” as “Tracking”. 

3. Press “S”, and select the input channel CH1 or CH2 of the tracked signal.   

4. Press “E”, and select the input channel CH1 or CH2 of the tracked signal.   

5. Press “S”, and rotate the [UNIVERSAL] knob to horizontally move “S”. 

6. Press “E”, and rotate the [UNIVERSAL] knob to horizontally move “E”. 

7. The measurement value list on the menu button “F5”  

S→T: Position (namely the time based on the horizontal central position) of “S” in the horizontal 

direction.   

S→V: Position (namely the voltage based on the grounded point of the channel) of “S” in the 

vertical direction.   

E→T: Position (namely the time based on the horizontal central position) of “E” in the horizontal 

direction.   

E→V: Position (namely the voltage based on the grounded point of the channel) of “E” in the 

vertical direction.   
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dt: Horizontal distance (namely the time value between the two cursors) of “S” and “E”. 

1/dt: Frequency of “S” and “E”.   

dV: Vertical distance (namely the voltage value between the two cursors) of “S” and “E”.   

 

 

2.11.3 Measurement 

Push the MEASURE button to perform auto measurements. There are 32 types of measurements 

and up to 8 can be displayed at a time.  

Turn the V0 knob to select an unspecified option. Press V0 or F6 when the red arrow icon stops on 

it. Then the following menu appears. 

Use the knob V0 or the functional keys to select the type of measurement. Measurement setting is 

described as shown in table: 

Options Settings Comments 

Source 
CH1  

CH2 
Select the measure source. 

Measurement Type 

1 Frequency Calculate the waveform frequency by measuring the first cycle. 

2 Period Calculate the time of the first cycle. 

3 Mean Calculate the arithmetic mean voltage over the entire waveform. 

4 Pk-Pk 
Calculate the absolute difference between the greatest and the 

smallest peaks of the entire waveform. 

5 CRMS Calculate the Root Mean Square voltage over the entire waveform. 

6 PRMS 
Calculate the actual RMS measurement of the first complete cycle in 

the waveform. 

7 Min 
The most negative peak voltage measured over the entire 

waveform. 

8 Max The most positive peak voltage measured over the entire waveform. 

9 Rising 
Measure the time between 10% and 90% of the first rising edge of 

the waveform. 

10 Falling 
Measure the time between 90% and 10% of the first falling edge of 

the waveform. 

Voltage Cursor Time Cursor 
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11 + Width 
Measure the time between the first rising edge and the next falling 

edge at the waveform 50% level. 

12 - Width 
Measure the time between the first falling edge and the next rising 

edge at the waveform 50% level. 

13 + Duty 
Measure the first cycle waveform. Positive Duty Cycle is the ratio 

between positive pulse width and period. 

14 - Duty 
Measure the first cycle waveform. Negative Duty Cycle is the ratio 

between positive pulse width and period. 

15 Base Measure the highest voltage over the entire waveform. 

16 Top Measure the lowest voltage over the entire waveform. 

17 Middle Measure the voltage of the 50% level from base to top. 

18 Amplitude Voltage between Vtop and Vbase of a waveform. 

19 Overshoot 
Defined as (Base - Min)/Amp x 100 %, Measured over the entire 

waveform. 

20 Preshoot 
Defined as (Max - Top)/Amp x 100 %, Measured over the entire 

waveform. 

21 PMean 
Calculate the arithmetic mean voltage over the first cycle in the 

waveform. 

22 FOVShoot Defined as (Vmin-Vlow)/Vamp after the waveform falling. 

23 RPRESoot Defined as (Vmin-Vlow)/Vamp before the waveform falling. 

24 BWidth The duration of a burst measured over the entire waveform. 

25 Delay 1-2 ↑ 
The time between the first rising edge of source 1 and the first rising 

edge of source 2. 

26 Delay 1-2 ↓ 
The time between the first falling edge of source 1 and the first 

falling edge of source 2. 

27 LFF 
The time between the first falling edge of source 1 and the last 

falling edge of source 2. 

28 LFR 
The time between the first falling edge of source 1 and the last rising 

edge of source 2. 

29 LRF 
The time between the first rising edge of source 1 and the last falling 

edge of source 2. 

30 LRR 
The time between the first rising edge of source 1 and the last  

rising edge of source 2. 

31 FFR 
The time between the first falling edge of source 1 and the first  

rising edge of source 2. 

32 FRF 
The time between the first rising edge of source 1 and the first  

falling edge of source 2. 

 Off Do not take any measurement. 
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Use the knob V0 or the functional keys F3, F4 to select the type of measurement. 

 

Taking Measurements: For a single waveform (or a waveform divided among multiple 

waveforms), up to 8 automatic measurements can be displayed at a time. The waveform channel 

must stay in an ‘ON’ (displayed) state to facilitate the measurement. The automatic measurement 

can not be performed on reference or math waveforms, or in XY or Scan mode. 

2.12 Acquisition System 

Push the ACQUIRE button to set the acquisition parameter. 

Options Settings Comments 

Type 
Real Time 

Equ-Time 

Acquire waveforms by real-time digital technique. 

Rebuild waveforms by equivalent sample technique. 

Mode 

(Real Time) 

Normal 

Peak Detect 

Average 

Acquire and accurately display most waveforms. 

Detect glitches and eliminate the possibility of aliasing. 

Reduce random or uncorrelated noise in signal display. 

The number of averages is selectable. 

Averages 

(Real Time) 

4, 8, 16, 32 

64, 128 
Select the number of averages by pressing F3 or F4. 

Memory Depth 

(Real Time) 
4K, 20K, 40K Select the memory depth for different board models. 

Normal: For the oscilloscope model with the bandwidth of 100MHz, the maximum sample rate is 

1GS/s. For time base with insufficient sample rate, you may use the Sine Interpolation Algorithm to 

interpolate points between sampled points to produce a complete waveform record (4K by 

default). 

The readouts in big font size on 

the menu are just results of the 

corresponding measurements. 
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Peak Detect: Use this mode to detect glitches within 10ns and to limit the possibility of aliasing. 

This mode is valid at the SEC/DIV setting of 4µs/div or slower. Once you set the SEC/DIV setting 

to 4µs/div or faster, the acquisition mode will change to Normal because the sample rate is fast 

enough that Peak Detect is unnecessary. The oscilloscope does not display a message to tell you 

that the mode has been changed to Normal. 

Average: Use this mode to reduce random or uncorrelated noise in the signal to be displayed. 

Acquire data in Normal mode and then average a great number of waveforms. Choose the 

number of acquisitions (4, 16, 64 or 128) to average for the waveform. 

Stopping the Acquisition: When you are running the acquisition, the waveform display is live. 

Stop the acquisition (press the RUN/STOP button) to freeze the display. In either mode, the 

waveform display can be scaled or positioned by vertical and horizontal controls. 

Equivalent Acquisition: Just repeat the Normal acquisition. Use this mode to take a specific 

observation on repeatedly displayed periodic signals. You can get a resolution of 40ps, i.e. 

25GSa/s sample rate, which is much higher than that obtained in real-time acquisition. 

The acquisition principle is as follows. 

 

As shown above, acquire input signals (cycle repeatable) for more than once at a slow sample rate, 

arrange the sample points by the time they appear, then recover waveforms.  

 

Sample Points 

 

Normal Acquisition Intervals 

8 3 7 2 4 5 6 1 9 10 

Normal Mode Acquires a Single Sample Point in Each Interval 

Input repeated signals 

First Acquisition 

Second Acquisition 

Third Acquisition 

Fourth Acquisition 
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2.13 UTILITY System 

Push the UTILITY button to display the Utility Menu as follows. 

Options Comments 

System Info Display the software and hardware versions, serial number and some other 

information about the oscilloscope.   

Update Program  Insert a USB disk with upgrade program and the disk icon at the top left 

corner is highlighted. Press the Update Program button and the Software 

Upgrade dialog pops up. Push F6 to upgrade or push F2 to cancel.  

Save Waveform Insert a USB disk and the disk icon at the top left corner is highlighted. Click 

on this icon and you can see the waveform pause for a while, being saved. 

You can find the saved waveform data under the Hantek_x folder in the USB 

disk. Here X represents how many times you press the button. Each press 

generates a corresponding folder. For example, press once and a folder 

Hantek_1 is generated; press twice and two folders Hantek_1, Hantek_2 

are generated. 

Self Calibration Press this option and the Self Calibration dialog pops up. Press F6 to 

perform the self calibration. Press F4 to cancel. 

Keepad Beep Turn on or turn off key beep. 

GUI Language Set the language 

GUI color Set the GUI color, bule, black, green, pink, yellow. 

Time Set the time setting. 

Sys Status Display the system status. 

Pass/Fail Pass/Fail function 

Recorder Turn on record function. 

Filter Filter setting. 

Print Cfg Set print configuration 

Option Bode Assiant: 

Wave: Save waveform as .hws file to Flash, SD or USB device. 

DDS: Enable waveform generator function. 

DVM:  

Tip: Press any menu button on the front panel to remove the status display and enter a 

corresponding menu. 

2.13.1 Firmware Update 

This series of oscilloscope can upgrade the software by the USB flash disc, which needs about 5 

minutes. 

The firmware is upgraded by the following steps:    

1. Plug the USB flash disc in which a firmware program is saved in USB Host interface                   

on the front panel of the oscilloscope.   

2. Press [UTILITY] to skip to the “UTILITY” menu.   

3. Press “Firmware Update”. 
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4. Refer to Upgrade dialog and push F6 to upgrade. 

Reboot the machine after finishing upgrading, and the software version is upgraded. The 

oscilloscope should be self-corrected once after upgrading. 

2.13.2 Self Calibration 

The self calibration routine helps optimize the oscilloscope signal path for maximum measurement 

accuracy. You can run the routine at any time but should always run it if the ambient temperature 

changes by 5℃ or more. For a more accurate calibration, please power on the oscilloscope and 

wait for 20 minutes until it has adequately warmed up. 

To compensate the signal path, disconnect any probes or cables from the front-panel input 

connectors. Then, push the UTILITY button, select the Do Self Cal option and follow the directions 

on the screen. 

2.13.3 Keypad Beep Control 

Press “Utility->F6” to page 2 of utility menu to select “Keypad Beep”. Press “F1” button to activate 

or deactivate it. 

2.13.4 Language 

This series oscilloscope is equipped with several languages. User can select a language. 

To choose the display language, press "UTILITY" button, then press “F6” to utility menu. Press 

"F2" to switch language. 

2.13.5 GUI Color Setting 

This series oscilloscope is equipped with several GUI styles. User can select a style. 

Press “Utility” button and “F6” button to page 2 of utility menu. Then press “F2” button to change 

GUI color style. 

2.13.6 Time Setting 

Press “Utility->F6” to page 2 of utility menu to select “Time”. Press “F4” button to set system time. 

2.13.7 System Status 

Press “Utility->F6” to page 2 of utility menu to select “Sys Status”. Users can know system status 

on screen. 

2.13.8 Pass/fail 

“Pass/fail” is used for judging whether the input signal is in a built rule range and outputting the 

past or failed waveform so as to detect the change condition of the signal. 

Page 1 of the pass/fail function menu: 

Option  Setup  Description  

Enable Test 
Run  

Stop  

Run the pass/fail function.  

Stop the pass/fail function.  



Basic Operation 

DSO4000 Series Digital Storage Oscilloscope                                                         41 

Source 
CH1 

CH2 
Select the signal input channel. 

Operation 
Run 

Stop 

Run pass/fail  

Stop pass/fail 

Display 
information 

Off 

On 

Close waveform pass/fail time display information. 

Open waveform pass/fail time display information.   

Page 1/2  Skip to page 2 to the pass/fail menu. 

Page 2 of the pass/fail function menu: 

Option  Setup  Description  

Output 

Pass 

Fail 

Pass Ring 

Fail Ring 

Output a negative pulse train when the test is passed. 

Output a negative pulse train when the test is failed. 

Output a negative pulse train when the test is passed and rings. 

Output a negative pulse train when the test is failed and rings.  

Stop on 

Output 

On 

Off 

Enter STOP state if output exits. 

Continue to run if output exits. 

Rule setup  Skip to a rule setup menu. 

Page 2/2  Back to t page 1 to the pass/fail menu. 

Rule setup menu: 

Option  Setup  Description  

Vertical  
Use the [UNIVERSAL] knob to set a horizontal tolerance range: 

0.020div-4.00div. 

Horizontal  
Use the [UNIVERSAL] knob to set a vertical tolerance range: 

0.025div-8.00div. 

Operation 
Create 

Save 

Create a rule template according to the two setups above.   

Select a save position for the rule. 

Back  Back to page 2 of the pass/fail menu. 

Rule save menu: 

Option  Setup  Description  

Storage 
Local Memory 

USB Flash 
Select location of saved rule 

Location 0-9   

Operation 
Save 

Recall 

Save the rule setups. 

Recall the waved rule setups.   

Back  Back to page of the rule setup menu. 

 

Pass/Fail output   

The pass/fail function can be used for outputting a negative pulse train through a Pass/Fail BNC 

interface on a rear panel of the oscilloscope. 
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Pass/Fail Test result                        Waveform recording 

2.13.9 Recorder 

The waveform recording function can be used for recording waveforms input by channel 1 and 

channel 2. The user can set the time interval of the frames within 1ms-999s. At most 1000 frames 

of waveforms can be recorded. The waveforms can be replayed after being recorded.  

Waveform recording: Record the waveforms at a specified time interval until reaching the set end 

frame number.  

Waveform recording function menu:    

Option  Setup  Description  

Function 

Off 

Record 

Play 

Save 

Set a recording function menu.   

Set a replay function menu. 

Source 
CH1 

CH2 
Set a recording signal source. 

Time interval 1ms-999s Set the time interval for waveform recording. 

End Frame 1-1000 Set the Max. frame number of recording 

Operation 
Start 

Stop 

Start to record the waveform.   

Stop recording the waveform.   

 
As shown in figure 2-57, the operation steps of waveform recording are as follows:  

1. Press [UTILITY] to skip to the [UTILITY] menu. 

2. Press “F6” to skip to page 3 of the utility menu.  

3. Press “Recorder” to skip to the “RECORD” menu. 

4. Press the “Function” key to select “Record”. 

5. Press the “Source” key to select the signal channel to be recorded.   

6. Select the “Time interval” option, and use the [V0] knob to regulate the time interval of frame to 

frame in waveform recording.   

7. Select the “End frame” option, and use the [V0] knob to regulate the maximal frame number in 

the waveform recording.   

8. Press the “Operation” option “Start” to record the waveform. 
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Recording replay: Replay the current recorded waveforms.    

Page 1 of the waveform replay function menu:     

Option  Setup  Description  

Function Play Set a replay function menu. 

Mode 
Repeat  

Single 

Repeatedly replay the recorded waveform.   

Replay the recorded waveform in single run. 

Time interval  Set the time interval of the replayed frame to frame. 

Start frame  Set start frame of playing 

End frame  Set end frame of playing 

Page 1/2  Skip to page 2 of play menu 

Page 2 of the waveform replay function menu:   

Option  Setup  Description  

Current Frame   

Operation 
Start 

Stop 

Start to replay waveform 

Stop to reply waveform 

Page 2/2  Back to page 1 of the replay function menu.   

2.13.10 Filter 

Press “Utility->F6->F6” to page 3 of utility menu to select “Filter”. Press “F3” button to select filter 

type Low Pass, High Pass, Band Pass or Band Stop. 

2.13.11 Wave 

Press “Utility->F6->F6” to page 3 of utility menu to select “Wave”.  

Options Settings Comments 

Source 
CH1 

CH2  
Select a waveformsource to store. 

Media 

Flash Save the source waveform to flash. 

USB Save the source waveform to USB device. 

SD Save the source waveform to SD card. 

Loacation 0~99 Select stored location when save waveform to flash media. 

Page 2/2 

Operation 

Save Save the source waveform to the selected reference location. 

Recall Recall saved source waveform to the selected reference location. 

Delete Delete saved waveform. 

SD to USB Copy waveform files to USB device. 

2.13.12 DDS 

Press “Utility->F6->F6” to page 3 and select “Option->DDS” of utility menu to enable to waveform 

generator function.  
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2.13.13 DVM 

Press “Utility->F6->F6” to page 3 and select “Option->DVM” of utility menu to calculate the Root 

Mean Square voltage over the entire waveform(CRMS). 

2.14 Help System 

This oscilloscope has a Help system with topics covering all of its features. You can use the Help 

system to display several kinds of information: 

 General information about understanding and using the oscilloscope, such as Using the Menu 

System. 

 Information about specific menus and controls, such as the Vertical Position Control. 

 Advice to problems you may come across while using an oscilloscope, such as Reducing 

Noise. 

The Help system provides three methods for you to find the information you want: 

context-sensitive, hyperlinks, and an index. 

 Context-Sensitive 

Push the HELP front-panel button and the oscilloscope displays information about the last menu 

displayed on the screen. The HELP SCROLL LED lights beside the HORIZONTAL POSITION 

knob indicate the alternative function of the knob. If a topic uses more than one page, turn the 

HELP SCROLL knob to move from page to page within the topic. 

 Hyperlinks 

Most of the help topics contain phrases marked with angle brackets, such as <Autoset>. They are 

links to other topics. Turn the HELP SCROLL knob to move the highlight from one link to another. 

Push the Show Topic option button to display the topic corresponding to the highlighted link. Press 

the Back option button to return to the previous topic. 

 Index 

Push the front-panel HELP button, and then press the Index option button. Push the Page Up or 

Page Down option button until you find the index page which contains the topic you want to view. 

Turn the HELP SCROLL knob to highlight a help topic. Press the Show Topic option button to 

display the topic. 

NOTE: Press the Exit option button or any menu button to remove the Help text from the 

screen and return to displaying waveforms. 
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2.15 Fast Action Buttons  

  

RUN/STOP: Continuously acquire waveforms or stop the acquisition.  

SINGLE SEQ: Acquire a single waveform and then stop the acquisition. 

AUTOSET: Automatically set the oscilloscope controls to generate a usable display of the input 

signals. Refer to the following table for relative content. 

2.15.1 Autoset 

Autoset is one of the advantages digital oscilloscopes have. When you push the AUTOSET button, 

the oscilloscope will identify the type of waveform (sine or square wave) and adjust controls 

according to input signals so that it can accurately display the waveform of the input signal. 

Functions Settings 

Acquire Mode Adjusted to Normal or Peak Detect 

Cursor Off 

Display Format Set to YT 

Display Type Set to Vectors for an FFT spectrum; otherwise, unchanged 

Horizontal Position Adjusted 

SEC/DIV Adjusted 

Trigger Coupling Adjusted to DC, Noise Reject or HF Reject 

Trigger Holdoff Minimum 

Trigger Level Set to 50% 

Trigger Mode Auto 

Trigger Source Adjusted; Autoset can not be used for the EXT TRIG signal 

Trigger Slope Adjusted 

Trigger Type Edge 

Trigger Video Sync Adjusted 

Trigger Video Standard Adjusted 

Vertical Bandwidth Full 
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Vertical Coupling 
DC (if GND was chosen before); AC for the video signal; otherwise, 

unchanged 

VOLTS/DIV Adjusted 

The Autoset function examines all channels for signals and displays corresponding waveforms. 

Autoset determines the trigger source according to the following conditions. 

 If multiply channels get signals, the oscilloscope will use the channel with the lowest 

frequency signal as the trigger source. 

 If no signals are found, the oscilloscope will use the lowest-numbered channel displayed 

in Autoset as the trigger source.  

 If no signals are found and no channels are displayed, the oscilloscope will display and 

use Channel 1 as the trigger source. 

Sine Wave: 

When you use the Autoset function and the oscilloscope determines that the signal is similar to a 

sine wave, the oscilloscope displays the following options.  

Sine Wave Options Details 

Multi-cycle Sine  
Display multiple cycles that have appropriate vertical and horizontal 

scales. 

Single-cycle Sine Set the horizontal scale to display about one cycle of the waveform. 

FFT 

Convert the input time-domain signal to its frequency components 

and display the result as a graph of frequency versus amplitude 

(spectrum). Since it is a math calculation, see Section 5.3.1 Math FFT 

for more information. 

Undo Setup Let the oscilloscope recall the previous setup. 

Square Wave or Pulse: 

When you use the Autoset function and the oscilloscope determines that the signal is similar to a 

square wave or pulse, the oscilloscope displays the following options.  

Square Wave Options Details 

Multi-cycle Square 
Display multiple cycles that have appropriate vertical and horizontal 

scales. 

Single-cycle Square 

Set the horizontal scale to display about one cycle of the waveform. 

The oscilloscope displays Min, Mean and Positive Width automatic 

measurements.  

Rising Edge Display the rising edge. 

Falling Edge Display the falling edge. 

Undo Setup Let the oscilloscope recall the previous setup. 
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2.16 Waveform Generator and Power Amplifier 

2.16.1 Waveform Generator 

DSO4000 series oscilloscope is equipped with waveform generator function, with one channel of 

arbitrary waveform output. User can edit the arbitrary waveform or choose the regular waveforms 

such as Sine, Ramp, Square, Trapezia, DC, Exponent, AM/FM.  

Push the GEN button to display the DDS Menu. 

 

Generate the Sine waveform 

To output a Sine Wave, please do the following steps: 

1. Press F1 button to select "Sine". 

2. Set the Wave Parameter: 

Frequency: Set the output wave frequency. 

Amplitude: Set the output wave amplitude. 

Y Offset: Set the output wave vertical level offset. 

Output: Select output type continuous or single. 

Ext Trig: Turn on or turn off external trigger, select rise edge or falle dge. 

Generate the Ramp waveform 

To output a Ramp Wave, please do the following steps: 

1. Press F2 button to select "Ramp". 

2. Set the Wave Parameter: 

Frequency: Set the output wave frequency. 

Amplitude: Set the output wave amplitude. 

Y Offset: Set the output wave vertical level offset. 

Wave Param: 

Duty: The duty of the output wave. 

Output: Select output type continuous or single. 

Ext Trig: Turn on or turn off waveform output, select rise edge or falle dge. 

Generate the Square waveform 

To output a Square Wave, please do the following Step: 

1. Press F2 button to select "Square". 
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2. Set the Wave Parameter: 

Frequency: Set the output wave frequency. 

Amplitude: Set the output wave amplitude. 

Y Offset: Set the output wave vertical level offset. 

Wave Param: 

Duty: The duty of the output wave. 

Output: Select output type continuous or single. 

Ext Trig: Turn on or turn off external trigger, select rise edge or falle dge. 

Generate the Trapezia waveform 

To output a Trapezia wave, please do the following steps: 

1. Press F2 button to select "Trapezia". 

2. Set the Wave Parameter: 

Frequency: Set the output wave frequency. 

Amplitude: Set the output wave amplitude. 

Y Offset: Set the output wave vertical level offset. 

Wave Param: 

Rise Duty: Set the output wave rise duty. 

High Duty: Set the output wave high duty. 

Fall Duty: Set the output wave fall duty. 

Output: Select output type continuous or single. 

Ext Trig: Turn on or turn off external trigger, select rise edge or falle dge. 

Generate the Exponent waveform 

To output an Exponent Waveform, please do the following steps: 

1. Press F2 button to select the wave "Exponent". 

2. Set the Wave Parameters: 

Frequency: Set the output wave frequency. 

Amplitude: Set the output wave amplitude.  

Y Offset: Set the output wave vertical level offset. 

Output: Select output type continuous or single. 

Ext Trig: Turn on or turn off external trigger, select rise edge or falle dge. 

Wave Param: 

Time: Set the ouput wave Tao param. 

Ext Type: Set the output wave slope to rise or fall. 

Generate the AM/FM waveform 

To output an AM/FM Wave, please do the following Steps: 

1. Press F2 button to select "AM/FM". 
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2. Set the Wave Parameter: 

Frequency: Set the output modulation wave frequency. 

Amplitude: Set the output modulation wave amplitude. 

Y Offset: Set the output modulation wave vertical level offset. 

Output: Select output type continuous or single. 

Ext Trig: Turn on or turn off external trigger, select rise edge or falle dge. 

Wave Param: 

Type: Select "AM" or "FM". 

Fo: Set the carrier wave frequency.  

Depth: Set the wave Depth. 

Max Freq: Set the wave Max frequency deviation. 

Edit Arbitrary Waveform 

User can't edit arbitrary waveform directly under DDS interface for the device. Firstly, please 

double click “Setup.exe” in Tools folder and install DDS-ARB software according to installation 

wizard. After DDS-ARB software installed successfully, you can see DDS-ARB icon on desktop. 

Double-click the icon, user can select "waveform parameters - > Arb" to edit arbitrary waveform. 
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1) Click “Wave Parameter->Parameter” to sewaveform frequency and poin number. The 

maximum of point is 4096. 

2) Click “Edit->Points Edit” to set pointindex and voltage. Also user can drag left mouse to 

edit points. 

 

3) Click “File->Save CSV”, and save CSV file to U disk or other paths.  

 

4) Insert U disk to the USB port of the device, select wave as "Arb ". Then press "Recall" 

menu to recall saved file. Use a test lcable connect the signal to the signal output terminal, 

observe the output waveform figure as follows: 
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2.16.2 Power Amplifier(Optional) 

If users set the Power Amplifier Out to turn on, the power amplifier board will work in the 

instrument. When using the power amplifier, use a connecting cable to input the signal to the input 

terminal “GEN OUT”, there will be a 2-time-amplified signal in the output terminal “2 time power 

amplifier output”. The input signal should be the GEN OUT signal, not external signal. 

Frequency Range 

The frequency range of power amplifier is 10Hz~150kHz. Amplitude flatness within this frequency 

range is better than 3%, and sine distortion is better than 1%. The maximum testing frequency is 

up to 200kHz. 

Output Power 

The equation for output power of power amplifier is: 

P=V
2
/R 

P is the output power, with the unit of W 

V is the output amplitude RMS value, with the unit of Vrms 

R is the load resistance, with the unit of Ω 

The maximum output amplitude is up to 22Vpp (7.8Vrms). The minimum load resistance is 2Ω. As 

the ambient temperature increases, the output signal frequency increases too. The lower output 

signal distortion is required, the smaller the max.output power is. Generally, the maximum output 

power can be up to 7W (8Ω) or 1W (50Ω). 

Output Protection 

The power amplifier has short circuit protection and over heat protection. It may not be burnt out in 

common operation. However, to prevent damage to power amplifier’s performance, long time 
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short circuit output should be avoided. Please also avoid to frequently using the maximum value of 

the frequency, amplitude and load. 

Power Amp Out 

Power Out: Turn on or turn off power amplifier out. 



 

 

Chapter 3 Application Examples 

This chapter unfolds a further description on main features of the oscilloscope by giving eleven 

simplified application examples for reference to help solve your own test problems. 

1. Taking simple measurements 

Using AUTOSET 

Using the Measure menu to take auto measurements 

2. Taking cursor measurements 

Measuring ring frequency and ring amplitude 

Measuring pulse width 

Measuring rise time 

3. Analyzing input signals to eliminate random noise 

Observing a noisy signal 

Eliminating random noise 

4. Capturing a single-shot signal 

5. Using X-Y mode 

6. Triggering on a pulse width 

7. Triggering on a video signal 

Observing triggers on video fields and video lines 

8. Using Slope Trigger to capture a particular slope signal 

9. Using Overtime Trigger to measure a long pulse signal 

10. Using math functions to analyze waveforms 

11. Measuring data propagation delay 
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3.1 Example 1: Taking Simple Measurements 

When you want to observe an unknown signal in a certain circuit without having its amplitude and 

frequency parameters, you may use this function to take a fast measurement on the frequency, 

period and peak-to-peak amplitude of the signal. 

Follow the steps below. 

1. Set the switch on the oscilloscope probe to 10X; 

2. Push the CH1 MENU button and set the Probe option attenuation to 10X; 

3. Connect the CH1 probe to the test point of the circuit; 

4. Press the AUTOSET button. 

The oscilloscope will automatically set the waveform to a best display. If you want to further 

optimize the waveform display, you may manually adjust the vertical and horizontal controls until 

the waveform meets your particular requirement. 

 

Taking Auto Measurements 

The oscilloscope can display most signals by automatic measurements. To measure such 

parameters as the signal frequency, period, peak-to-peak amplitude, rise time and positive width, 

follow the steps below. 

1. Push the MEASURE button to see the Measure menu. 

2. Turn the knob V0 to select the first ‘unspecified’ option (marked by red arrow), press V0 or F6 

to enter the submenu. 

3. Select CH1 for the Source option. Then repeatedly push F3 or F4 to select measure items in 

the Type menu. Push the back menu to go back to the measure interface. Or turn and push 

V0 to select a measure item and go back to the measure interface. The corresponding box 

under the measure item shows the measurements. 

4. Repeat Step 2 and Step 3. Then select other measure items. Totally 8 measure items can be 

displayed. 

Note: All readouts change with the measured signals. 
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The figure below shows three measure items as an example. The boxes under them display the 

measurements in large fonts. 

 

3.2 Example 2: Taking Cursor Measurements 

You can use the cursor to quickly measure the time and amplitude of a waveform. 

Measuring Ring Time (convertible to Frequency) and Amplitude on Rising Edge of Pulse 

To measure the ring time on the rising edge of the pulse, follow the steps below. 

1. Push the CURSOR button to view the Cursor menu. 

2. Push F1 the Type option button and select Time. 

3. Push F2 or F3 the Source option button and select CH1. 

4. Push F4 to select a cursor. If S is selected, turn V0 to move Cursor S on the screen; if E is 

selected, turn V0 to move Cursor E; if both are selected, turn V0 to move them at the same 

time. 

5. Put Cursor S on the first peak of the ring. 

6. Put Cursor E on the second peak of the ring. 

7. At Delta displays the measured time and at Cursor S an Cursor E display the positions of 

these two cursors.  

8. Push the Type option button and select Voltage.  

9. Put Cursor S on the highest peak of the ring. 

10. Put Cursor E on the lowest point of the ring. The amplitude of the ring will be displayed at 

Delta. 

See figures below for better understanding. 
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Measuring Pulse Width 

To analyze a pulse signal and to know its width, follow the steps below. 

1. Push the CURSOR button to view the Cursor menu. 

2. Push F1 the Type option button and select Time. 

3. Push F2 or F3 the Source option button and select CH1. 

4. Push F4 to select a cursor. If S is selected, turn V0 to move Cursor S on the screen; if E is 

selected, turn V0 to move Cursor E; if both are selected, turn V0 to move them at the same 

time. 

5. Place Cursor S on the rising edge of the pulse and Cursor E on the falling edge. 

6. Thus at Delta displays the measured time and at Cursor S and Cursor E displays the time 

relative to the trigger. 

See the figure below for better understanding. 
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Measuring Rise Time of Pulse 

You may need to measure the rise time of the pulse in many application environments, usually, to 

measure the rise time between the 10% and 90% levels of the pulse waveform. To do so, follow 

the steps below. 

1. Turn the SEC/DIV knob to display the rising edge of the waveform. 

2. Turn the VOLTS/DIV and VERTICAL POSITION knobs to adjust the waveform amplitude to 

about 5 divisions. 

3. Push the CH1 MENU button. 

4. Push the VOLTS/DIV option button and select Fine. Turn the VERTICAL POSITION knob to 

accurately separate the waveform into 5 divisions. 

5. Turn the VERTICAL POSITION knob to center the waveform. Position the waveform baseline 

to 2.5 divisions below the center graticule. 

6. Press the CURSOR button. 

7. Push the Type option button and select Time. Push the Source option button to select CH1. 

8. Select Cursor S and turn V0 to place it at the 10% level of the waveform. 

9. Select Cursor E and turn V0 to place it at the 90% level of the waveform. 

10. The Delta readout in the Cursor Menu is the rise time of the pulse. 

See the figure below for better understanding. 
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3.3 Example 3: Analyzing Input Signals to Eliminate 

Random Noise 

In certain circumstances, to display a noisy signal on the oscilloscope and to get its details, you 

may follow the steps below to analyze this signal. 

 

Observing Noisy Signal 

1. Press the ACQUIRE button to see the Acquire menu. 

2. Push the Type option button and select Real Time. 

3. Push the Peak Detect option button. 

4. If necessary, push the DISPLAY button and set the Contrast option to view the noise more 

clearly. 

5 divisions 
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See the figure below for better understanding. 

 

Eliminating Random Noise 

1. Press the ACQUIRE button to see the Acquire menu. 

2. Push the Type option button and select Real Time. 

3. Push the Average option button. 

4. Push the Averages option button and adjust the number of running averages to watch the 

change in the waveform display. 

Note: Averaging reduces random noise and let you view the signal details more easily. 

See the figure below for better understanding 
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3.4 Example 4: Capturing Single-shot Signal 

You may refer to the following example to easily capture some aperiodic signals like pulses and 

glitches. 

To set for a single-shot acquisition, follow the steps below. 

1. First, set up the oscilloscope probe and the attenuation factor of CH1. 

2. Turn the vertical VOLTS/DIV and horizontal SEC/DIV knobs to a proper position for a better 

examination of the signal. 

3. Press the ACQUIRE button to see the Acquire menu. 

4. Push the Peak Detect option button. 

5. Push the TRIG MENU button and select Rising for the Slope option. Then adjust the trigger 

level properly. 

6. Push the SINGLE SEQ button to start the acquisition. 

Using this feature can help you to capture occasional events more easily. This is an advantage of 

the digital storage oscilloscope. 

 

3.5 Example 5: Using X-Y Mode 

Viewing Phase Differences between Two Channel Signals 

For example, you need to measure the change in a phase across a circuit network. 

Connect the oscilloscope with circuitry and view the input and output of the circuit in XY mode. 

Follow the steps below. 

1. First, prepare two oscilloscope probes and set the switches to 10X on both probes. 
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2. Push the CH1 MENU button and set the Probe option attenuation to 10X; push the CH2 

MENU button and set the Probe option attenuation to 10X. 

3. Connect the CH1 probe to the input of the network, and connect the CH2 probe to the output. 

4. Push the AUTOSET button. 

5. Turn the VOLTS/DIV knobs to display approximately the same amplitude signals on each 

channel.                     

6. Push the DISPLAY button to see the Display menu. 

7. Push the Format option button and select XY. 

8. Now the oscilloscope displays a Lissajous pattern to characterize the input and output of the 

circuit. 

9. Turn the VOLTS/DIV and VERTICAL POSITION knobs to properly scale the waveform 

display.  

10. Use the Lissajous's oscillographic method to observe and calculate the phase differences 

following the formula below. 

As sinθ=A/B or C/D, in which θ is the phase difference angle between channels and A, B, C, D 

represent what shown in the figure below, you can get the value of the phase difference angle by 

the formula: θ=±arcsin(A/B) or ±arcsin(C/D). 

If the principal axes of the ellipse are in the first and third quadrants, the phase difference angle 

should be in the first and fourth quadrants, i.e. within (0~π/2) or (3π/2~2π). If the principal axes of 

the ellipse are in the second and fourth quadrants, the phase difference angle should be in the 

second and third quadrants, i.e. within (π/2~π) or (π-3π/2). See the figure below for better 

understanding. 

 

A B 

C 

D 

Signal Horizontal 
Centering 
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3.6 Example 6: Triggering on Pulse Width 

Triggering on a Specific Pulse Width 

While testing the pulse width of a signal in a circuit, you may need to verify the pulse width is 

consistent with the theoretic value. Or even if the edge triggering shows that your signal has the 

same pulse width with the specific signal, you still doubt about the result. Then you can follow the 

steps below. 

1. Set the Probe option attenuation to 10X. 

2. Push the AUTOSET button to trigger a stable waveform display. 

3. Push the Single Cycle option button in the Autoset menu and read out the signal pulse width. 

4. Push the TRIG MENU button. 

5. Push F1 to select Pulse for the Type option; push F2 to select CH1 for the Source option; turn 

the TRIGGER LEVEL knob to set the trigger level at the bottom of the signal.  

6. Push F6 to enter the next page. Select the When option button and Push F4 to select ‘=’. 

7. Push the Set Pulse Width option button. Turn V0 to set the pulse width to the value read out in 

Step 3. 

8. Turn the TRIGGER LEVEL knob to set the pulse width to the value read out in Step 3. 

9. Push the More option button and select Normal for the Mode option. Once triggering on 

normal pulses, the oscilloscope can give a stable waveform display. 

10. If the When option is set to >, < or ≠ and there appear any aberrant pulses that meet the 

specified condition, the oscilloscope will trigger. For example, the signal contains such 

aberrant pulses as shown below, you may select ‘≠’ or ‘<’ to trigger on the pulse. 

 

As shown in the above figure, you can get a stable waveform display if inputting a square wave at 

the frequency of 1KHz, with pulse width set to 500μs. 
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3.7 Example 7: Triggering on Video Signal 

Assume that you are monitoring the video signals of a television to see if they are input normally, 

and the video signal is of an NTSC system. You can get a stable display by using the video trigger. 

Triggering on Video Fields 

To trigger on the video fields, follow the steps below. 

1. Push the TRIG MENU button to see the Trigger menu. 

2. Push F1 to select Video for the Type option. 

3. Push the Source option button to select CH1; push the Polarity option button to select Normal; 

push the Standard option button to select NTSC. 

4. Push the Sync option button to select Odd Field, Even Field or All Fields.  

5. Turn the Trigger Level knob to adjust the trigger level and stabilize video signals. 

6. Turn the horizontal SEC/DIV and the Vertical Position knobs to display on the screen a 

complete video signal triggering on a video field. 

The figure below shows a stable signal triggering on a video field. 

 

Triggering on Video Lines 

To trigger on the video lines, follow the steps below. 

1. Push the TRIG MENU button to see the Trigger menu. 

2. Push F1 to select Video for the Type option. 

3. Push the Source option button to select CH1; push the Polarity option button to select Normal; 

push the Standard option button to select NTSC; push the Sync option button to select Line 

Number. 

4. Turn the Trigger Level knob to adjust the trigger level and stabilize video signals. 
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5. Turn V0 to adjust the line number (NTSC: 0-525 lines). 

6. Turn the horizontal SEC/DIV and the vertical VOLTS/DIV knobs to display on the screen a 

complete video signal triggering on a video line. See the figure below. 

 

3.8 Example 8: Using Slope Trigger to Capture Particular 

Slope Signal 

In many occasions, we are not only concerned about the edge of the signal, but also want to know 

the rise and fall times of the signal. To better observe this kind of signals, we bring in the slope 

trigger. Follow the steps below.  

1. Push the TRIG MENU button to see the Trigger menu. 

2. Push F1 to select Slope for the Type option. 

3. Push the Source option button to select CH1; push the Slope option button to select Rising; 

push the Mode option button to select Auto; push the Coupling option button to select DC. 

4. Click the ‘Next Page’ button and select Vertical. Turn the V0 knob to adjust V1 and V2 to 

proper locations. Select the When option button and set it to ‘=’. 

5. Select ‘Time’ and turn V0 to adjust the time until you get a stable display of waveforms. See 

the figure below. 
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3.9 Example 9: Using Overtime Trigger to Measure Long 

Pulse Signal 

It is not easy to observe some part of a long pulse signal by using the edge or pulse width trigger. 

In such case, you can use the overtime trigger by following steps. 

1. Push the TRIG MENU button to see the Trigger menu. 

2. Push F1 to select OT for the Type option; push the Polarity option button to select Normal; 

push the Mode option button to select Auto; push the Coupling option button to select DC. 

3. Turn the Trigger Level knob to adjust the trigger level and stabilize video signals. 

4. Turn V0 to adjust the line number (NTSC: 0-525 lines). 

5. Turn the horizontal SEC/DIV and the vertical VOLTS/DIV knobs to display on the screen a 

complete video signal triggering on a video line. See the figure below. 
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Note: The difference between the overtime and the delay triggers is that the overtime 

trigger can identify the pulse you need according to your set time and trigger on any point 

of the pulse. In the other word, the overtime trigger occurs based on pulse identification. It 

is similar to the > mode of the pulse width trigger, but not the same.  

3.10 Example 10: Using Math Functions to Analyze 

Waveforms 

Using math functions to analyze input waveforms is another advantage of the digital oscilloscope. 

For example, you want to get the instantaneous difference between two channel waveforms. By 

using the math function of the oscilloscope, you can get a better representation of the waveform 

on the screen. To observe this signal, follow the steps below. 

1. Set the Probe option attenuation to 10X. 

2. Open CH1 and CH2 at the same time, both with the attenuation of 10X. 

3. Push the AUTOSET button to trigger a stable waveform. 

4. Push the MATH MENU button to see the Math menu. 

5. Push the Operation option button and select ‘CH1+CH2’. 

6. Turn the horizontal SEC/DIV and the vertical VOLTS/DIV knobs to properly scale the 

waveform for easy check. 

In addition, the oscilloscope also supports the - and FFT functions. For a detailed analysis on FFT, 

refer to Chapter 5.3.1 Math FFT. 

Note: You should compensate both probes before performing the math operation; 

otherwise, differences in probe compensation will appear as errors in the differential 

signal. 

 

As illustrated in the above figure, input a 1KHz sine wave from CH1 and a 1KHz square wave from 
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CH2. 

Follow the above steps to set up the Math menu, and observe the subtracted waveform as shown 

in the figure below. 

 

Those in pink are added waveforms. 

3.11 Example 11: Measuring Data Propagation Delay 

When you doubt that there appear instabilities in a serial data propagation control circuit, you can 

set the oscilloscope to measure the propagation delay between the enable signal and the transfer 

data. 

To set the propagation delay measurement, follow the steps below. 

1. Connect two oscilloscope probes respectively to the CS (chip-select) pin and the DATA pin on 

the chip. 

2. Set the Probe option attenuation to 10X for both probes. 

3. Open CH1 and CH2 at the same time, both with the attenuation of 10X.  

4. Push the AUTOSET button to trigger a stable waveform display. 

5. Adjust the horizontal and vertical controls to optimize the waveform display. 

6. Push the CURSOR button to view the Cursor menu. 

7. Push the Type option button and select Time. 

8. Select Cursor S and turn V0 to place it on the active edge of the enable signal. 

9. Select Cursor E and turn V0 to place it on the data output transition (See the figure below). 

10. Read the data propagation delay in the Delta readout. 
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Chapter 4 Troubleshooting 

4.1 Problem Settlement 

1. If the oscilloscope does not start up at power on, follow these steps: 

1） Check the power cord to verify it has been connected properly; 

2） Check the power on/off button to ensure it has been pushed; 

3） Then restart the oscilloscope. 

2. If there is no display of waveforms on the screen when the oscilloscope is turned on, 

follow these steps: 

1） Check the probe to assure its proper connection to the input BNC; 

2） Check the channel switch (such as CH1, CH2 menu buttons) to make sure it has been turned 

on; 

3） Check the input signal to verify it has been connected to the probe correctly; 

4） Affirm that all measured circuits have signals to output; 

5） Turn up the magnitude for DC signals with large magnitude; 

6） In addition, you may press the Auto Measure button to perform an automatic detection of 

signals at first. 

3. If the waveform of the input signal is distorted seriously, follow these steps: 

1） Check the probe to assure its proper connection to the channel BNC; 

2） Check the probe to assure its good connection to the measured object; 

3） Check the probe to verify it has been well calibrated. Otherwise, refer to the content about 

calibration described in this manual. 

4. If the waveform is rolling continuously on the screen but can not be triggered, follow 

these steps: 

1） Check the trigger source to make sure it consistent with the input channel; 

2） Check the trigger level to assure its correct adjustment. You may push the TRIGGER LEVEL 

knob or press the SET TO 50% button to reset the trigger level back to the center of the signal; 

3） Check the trigger mode to confirm it is a right choice for the input signal. The default trigger 

mode is edge trigger. However, it is not suitable for all kinds of input signals. 
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Chapter 5 Specifications 

5.1 Technical Specifications 

All specifications herein mentioned apply to the DSO4000 series oscilloscopes. Before checking 

an oscilloscope from your seller to see if it complies with these specifications, make sure it meets 

the following conditions: 

 The oscilloscope must have been operating continuously for twenty minutes under the 

specified operating temperature. 

 The Do Self Cal operation must be performed through the Utility menu if the operating 

temperature changes by more than 5℃. 

 The oscilloscope must be within the factory calibration interval. 

All specifications are guaranteed unless noted ‘typical’. 

Oscilloscope Specifications 

Horizontal 

Sample Rate Range 1GS/s 

Waveform Interpolation (sin x)/x 

Record Length 
Maximum 40K samples per single-channel; maximum 20K  

samples per dual-channel (4K, 20K optional) 

SEC/DIV Range 

DSO4072 DSO4102 DSO4202 

4ns/div to 40s/div, in a  2, 4, 8 

sequence 

2ns/div to 40s/div, in a  2, 4, 

8 sequence 

Sample Rate and 

Delay Time Accuracy 
±50ppm over any ≥1ms time interval 

Delta Time Measurement 

Accuracy  

(Full Bandwidth) 

Single-shot, Normal mode 

± (1 sample interval +100ppm × reading + 0.6ns) 

>16 averages  

± (1 sample interval + 100ppm × reading + 0.4ns) 

Sample interval = s/div ÷ 200 

Position Range 

DSO4072 DSO4102  

20ns/div to 80μs/div (-8div × s/div) to 40ms 

200μs/div to 40s/div (-8div × s/div) to 400s 

DSO4202 

2ns/div to 10ns/div (-4div × s/div) to 20ms 

 

 

Vertical 
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A/D Converter 
8-bit resolution, 

each channel sampled simultaneously 

VOLTS/DIV Range 2mV/div to 5V/div at input BNC 

Position Range 
2mV/div to 200mV/div, ±2V 

>200mV/div to 5V/div, ±50V 

Analog Bandwidth in 

Normal and Average 

modes at BNC or with probe, DC 

Coupled 

2mV/div to 20mV/div, ±400mV 

50mV/div to 200mV/div, ±2V 

500mV/div to 2V/div, ±40V 

5V/div, ±50V 

Selectable Analog Bandwidth Limit, 

typical 
20MHz  

Low Frequency Response (-3db) ≤10Hz at BNC 

Rise Time at BNC, typical 
DSO4072 DSO4102 DSO4202 

≤5.0ns ＜3.5ns <1.8ns 

DC Gain Accuracy 

±3% for Normal or Average acquisition mode, 5V/div to 

10mV/div 

±4% for Normal or Average acquisition mode, 5mV/div 

to 2mV/div 

DC Measurement Accuracy,  

Average Acquisition Mode 

Measurement Type: Average of ≥16 waveforms with 

vertical position at zero 

Accuracy: ± (3% × reading + 0.1div + 1mV) when 

10mV/div or greater is selected 

Measurement Type: Average of ≥16 waveforms with 

vertical position not at zero 

Accuracy: ± [3% × (reading + vertical position) + 1% of 

vertical position + 0.2div] 

Add 2mV for settings from 2mV/div to 200mV/div; add 

50mV for settings from 200mV/div to 5V/div 

Volts Measurement Repeatability,  

Average Acquisition Mode 

Delta volts between any two averages of ≥16 

waveforms acquired under same setup and ambient 

conditions 

 Note: Bandwidth reduced to 6MHz when using a 1X probe. 

Trigger 

Trigger Sensitivity 

(Edge Trigger Type) 

Coupling Sensitivity 

DC 

Source DSO4072, DSO4102 DSO4202 

CH1 

CH2 

1div from DC to 
10MHz; 

1.5div from 10MHz to 

Full 

1.5div from 10MHz 

to 100MHz; 

2div from 100MHz 

to Full 

EXT 
200mV from DC to 

100MHz 

200mV from DC to 

100MHz; 350mV 

from 100MHz to 

200MHz 
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EXT/5 1V from DC to 100MHz 

1V from DC to 

100MHz; 

1.75V from 

100MHz to 

200MHz 

AC Attenuates signals below 10Hz 

HF Reject Attenuates signals above 80kHz 

LF Reject 
Same as the DC-coupled limits for frequencies above 

150kHz; attenuates signals below 150kHz 

Trigger Level Range 

Source Range 

CH1, CH2 ±8 divisions from center of screen 

EXT ±1.2V 

EXT/5 ±6V 

Trigger Level 

Accuracy, typical 

(Accuracy is for 

signals having rise 

and fall times ≥20ns) 

Source Accuracy 

CH1、CH2 
0.2div × volts/div within ±4 divisions from center of 

screen 

EXT ± (6% of setting + 40mV) 

EXT/5 ± (6% of setting + 200mV) 

Set Level to 50%, 

typical 
Operates with input signals ≥50Hz 

Note: Bandwidth reduced to 6MHz when using a 1X probe. 

Video Trigger Type Source Range 

 

CH1, CH2 Peak-to-peak amplitude of 2 divisions 

EXT 400mV 

EXT/5 2V 

Signal Formats and 

Field Rates, Video 

Trigger Type 

Supports NTSC, PAL and SECAM broadcast systems for any field or 

any line 

Holdoff Range 100ns to 10s  

 

Pulse Width Trigger  

Pulse Width Trigger 

Mode 

Trigger when < (Less than), > (Greater than), = (Equal), or ≠ (Not Equal); 

Positive pulse or Negative pulse 

Pulse Width Trigger 

Point 

Equal: The oscilloscope triggers when the trailing edge of the pulse 

crosses the trigger level. 

Not Equal: If the pulse is narrower than the specified width, the trigger 

point is the trailing edge. Otherwise, the oscilloscope triggers when a 

pulse continues longer than the time specified as the Pulse Width. 

Less than: The trigger point is the trailing edge. 

Greater than (also called overtime trigger): The oscilloscope triggers 

when a pulse continues longer than the time specified as the Pulse 

Width. 

Pulse Width Range Selectable from 20ns to 10s 
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Slope Trigger  

Slope Trigger Mode 
Trigger when < (Less than), > (Greater than), = (Equal), or ≠ (Not Equal); 

Positive slope or Negative slope 

Slope Trigger Point 

Equal: The oscilloscope triggers when the waveform slope is equal to 

the set slope. 

Not Equal: The oscilloscope triggers when the waveform slope is not 

equal to the set slope. 

Less than: The oscilloscope triggers when the waveform slope is less 

than the set slope. 

Greater than: The oscilloscope triggers when the waveform slope is 

greater than the set slope. 

Time Range Selectable from 20ns to 10s 

Overtime Trigger The leading edge: Rising edge or Falling edge; Time Setting: 20-10s 

 

Swap Trigger  

CH1 Internal Trigger: Edge, Pulse Width, Video, Slope 

CH2 Internal Trigger: Edge, Pulse Width, Video, Slope 

 

Trigger Frequency 

Counter 
 

Readout Resolution 6 digits 

Accuracy (typical) ±30ppm (including all frequency reference errors and ±1 count errors) 

Frequency Range AC coupled, from 4Hz minimum to rated bandwidth 

Signal Source 

Pulse Width or Edge Trigger modes: all available trigger sources 

The Frequency Counter measures trigger source at all times, including 

when the oscilloscope acquisition pauses due to changes in the run 

status, or acquisition of a single shot event has completed. 

Pulse Width Trigger mode: The oscilloscope counts pulses of significant 

magnitude inside the 1s measurement window that qualify as triggerable 

events, such as narrow pulses in a PWM pulse train if set to < mode and 

the width is set to a relatively small time. 

Edge Trigger mode: The oscilloscope counts all edges of sufficient 

magnitude and correct polarity. 

Video Trigger mode: The Frequency Counter does not work. 

Acquisition 

Acquisition Modes Normal, Peak Detect, and Average 

Acquisition Rate, 

typical 

Up to 2000 waveforms per second per channel (Normal acquisition 

mode, no measurement) 

Single Sequence Acquisition Mode Acquisition Stop Time 

 
Normal,  

Peak Detect 

Upon single acquisition on all channels 

simultaneously 

 Average 
After N acquisitions on all channels simultaneously, 

N can be set to 4, 8, 16, 32, 64 or 128 
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Inputs 

Inputs  

Input Coupling DC, AC or GND 

Input Impedance, 

DC coupled 
1MΩ±2% in parallel with 20pF±3pF 

Probe Attenuation 1X, 10X 

Supported Probe 

Attenuation Factors 
1X, 10X, 100X, 1000X 

Maximum Input 

Voltage 

Overvoltage Category Maximum Voltage 

CAT I and CAT II 300VRMS (10×), Installation Category 

CAT III 150VRMS (1×) 

Installation Category II: derate at 20dB/decade above 100kHz to 13V 

peak AC at 3MHz* and above. For non-sinusoidal waveforms, peak 

value must be less than 450V. Excursion above 300V should be of less 

than 100ms duration. RMS signal level including all DC components 

removed through AC coupling must be limited to 300V. If these values 

are exceeded, damage to the oscilloscope may occur. 

Measurements 

Cursors 

Voltage difference between cursors: △V 

Time difference between cursors: △T 

Reciprocal of △T in Hertz (1/ΔT) 

Automatic 

Measurements 

Frequency, Period, Mean, Peak-to-peak, Cycle RMS, PRMS, Minimum, 

Maximum, Rise Time, Fall Time, + Width, - Width, + Duty, - Duty, Base, 

Top, Middle, Amplitude, Overshoot, Preshoot, Pmean, FOVShoot, 

RPREShoot, BWidth, Delay 1-2 ↑, Delay 1-2 ↓, LFF, LFR, LRF, LRR, 

FFR, EFRF 

 

General Specifications 

Display 

Display Type 7 inch 64K color TFT (diagonal liquid crystal) 

Display Resolution 800 horizontal by 480 vertical pixels 

Display Contrast Adjustable (16 gears) with the progress bar 

Probe Compensator Output 

Output Voltage, 

typical 
About 5Vpp into ≥1MΩ load 

Frequency, typical 1kHz 

Power Supply 

Supply Voltage 
100-120VACRMS(±10%), 45Hz to 440Hz, CATⅡ 

120-240VACRMS(±10%), 45Hz to 66Hz, CATⅡ 

Power Consumption <30W 

Fuse 2A, T rating, 250V 
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Environmental 

Temperature 
Operating: 32℉ to 122℉ (0℃ to 50℃) 

Nonoperating: -40℉ to 159.8℉ (-40℃ to +71℃) 

Cooling Method Convection 

Humidity 
+104℉ or below (+40℃ or below): ≤90% relative humidity 

106℉ to 122℉ (+41℃ to 50℃): ≤60% relative humidity 

Altitude Operating and Nonoperating 3,000m (10,000 feet) 

 Random Vibration 
0.31gRMS from 50Hz to 500Hz, 10 

minutes on each axis 

 Nonoperating 
2.46gRMS from 5Hz to 500Hz, 10 

minutes on each axis 

Mechanical Shock Operating 50g, 11ms, half sine 

Mechanical 

Size 

Length 313mm 

Height 142mm 

Depth 108mm 

Weight 
exclusive of packing and 

accessories 
2.08Kg 

 

Arbitrary Waveform Generator Mode 

Waveform Frequency DC~25MHz 

DAC 2K~200MHz adjustable 

Frequency Resolution 0.10% 

Channel 1CH waveform output 

Waveform Depth 4KSa 

Vertical Resolution 12 bit 

Frequency Stability <30ppm 

Wave Amplitude ±3.5V Max. 

Output Impedance 50 Ω 

Output Current 50mA, Ipeak=50mA 

System BW 25M 

Harmonic Distortion -50dBc(1KHz),  -40dBc(10KHz) 

 

Power Amplifier(Optional) 

Maximum power output 7W(8 Ω), 1W(50 Ω) 

Maximum output voltage 22Vpp 

Frequency bandwidth 1Hz~200KHz 
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5.2 Accessories 

All the following accessories are available. 

Standard Accessories 

Sketch Description 

 

X1, X10 two passive probes. The passive probes have a 6MHz bandwidth 

(rated 100Vrms CAT III) when the switch is in the X1 position, and a 

maximum bandwidth (rated 300Vrms CAT II) when the switch is in the X10 

position. Each probe consists of all necessary fittings. 

 

A USB A-B line, used to connect external devices with USB-B interface 

like a printer or to establish communications between PC and the 

oscilloscope. 

 

A power cord special for this product. In addition to the power cord shipped 

with your instrument, you may purchase another one certified for the 

country of use. 

 

A software installation CD. It contains the user manual of DSO4000, giving 

particular descriptions on the DSO4000 series oscilloscopes. 
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Chapter 6 General Care and Cleaning 

6.1 General Care 

Do not put or leave the device in a place where the LCD display will be exposed to direct sunlight 

for long periods of time. 

Note: To avoid damage to the oscilloscope or probes, do not expose them to sprays, liquids, or 

solvents. 

6.2 Cleaning 

Examine the oscilloscope and probes as often as operating conditions require. To clean the 

exterior surface, perform the following steps: 

1） Use a lint-free cloth to remove floating dust on the outside of the oscilloscope and probes. 

Take care to avoid scratching the glabrous display filter. 

2） Use a soft cloth dampened with water to clean the oscilloscope. For more efficient cleaning, 

you may use an aqueous solution of 75% isopropyl alcohol. 

Note: To avoid damage to the surface of the oscilloscope or probes, do not use any 

corrosive or chemical cleaning agents. 
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Appendix A Harmful and Poisonous 

Substances or Elements 

 Harmful and poisonous substances or elements
 1
 

Component
2
 Pb Hg Cd Cr(Vi) PBB PBDE 

Shell and Chassis X 0 0 X 0 0 

Display Module X X 0 0 0 0 

Circuit Board  X 0 0 X 0 0 

Power Supply  X 0 0 X 0 0 

Electric Wire and Cable Assembly X 0 0 0 0 0 

Connector X 0 0 X 0 0 

Fastener and Installed Hardware  X 0 X X 0 0 

Other Accessories (including 

probes) 
X 0 0 X 0 0 

Others 0 0 0 0 0 0 

 

‘X’ means that at least the content of this poisonous and harmful substance in a homogeneous 

material of this component exceeds the limit specified in the SJ/T 11363-2006 standard.   

‘0’ indicates that the content of this poisonous and harmful substance in all homogeneous 

materials of this component is refrained under the limit stated in the SJ/T 11363-2006 standard. 

This component list contains components approved in the file ‘Management Measures’. 
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